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1

Introduction

0.1 Présentation

CloudCompare est un logiciel de traitement et de comparaison de nuages de points 3D denses (ainsi que de
maillages triangulaires dans une certaine mesure). Son développement a été initié à partir de 2004 dans le cadre
d’une thèse CIFRE financée par EDF R&D et encadrée par l’Ecole Nationale Supérieure des Télécommunications
(ENST – désormais Telecom ParisTech – laboratoire TSI, équipe TII). Il se poursuit depuis et est désormais un projet
open-source indépendant. CloudCompare n’est pas voué à un usage commercial.

Historiquement, ce logiciel a été conçu pour traiter des nuages de points denses (tels que ceux issus d’un scanner
laser 3D) dans le but de les comparer pour en extraire les différences. Il permet donc typiquement :

– de calculer les distances locales entre deux nuages de points denses ou entre un nuage et un maillage trian-
gulaire (figure de gauche ci-dessous) ;

– de filtrer le bruit de mesure du scanner laser pour mettre en évidence les "vraies" différences (figure du milieu) ;
– de segmenter les points restants en sous-ensembles correspondant à des objets distincts (figure de droite).

Depuis, CloudCompare a beaucoup évolué et il offre désormais de nombreuses fonctions d’édition (transfor-
mation rigide interactive, segmentation interactive), de recalage automatique (type ICP), de modélisation (calcul de
maillages surfaciques type Delaunay ou Poisson), de reprojection (selon le point de vue du scanner, selon une di-
rection principale, sur un cylindre ou un cône, etc.), de calcul morphologiques (rugosité, courbure, etc.) et autres. A
travers un système de plugins, l’utilisateur a aussi accès à des fonctionalités et librairies externes (des algorithmes
issus du monde de la recherche - reconstruction de maillage par approche de type Poisson, filtrage des points non
visibles, etc. - des périphériques d’acquisition comme la Kinect de Microsoft, ou encore des shaders évolués pour
faciliter la visualisation des entités 3D - Eye Dome Lighting ou SSAO, etc.).

L’originalité de CloudCompare tient à plusieurs aspects :
– les structures de données utilisées : notamment un "octree" particulier permettant de traiter très rapidement
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des nuages de points volumineux (plusieurs millions de points 3D).
– un grand nombre de choix et de méthodes pour le calcul de distance entre nuages de points ou entre un nuage

et un maillage triangulaire (tous basés sur la notion de distance au plus proche voisin) ; et un calcul très rapide
mais moins précis basé sur une distance de Chanfrein ;

– la possibilité de prendre en compte les différences d’échantillonnage entre les jeux de données comparés ;
– la possibilité de filtrer le bruit de mesure a posteriori ;
– la possibilité de prendre en compte la visibilité du scanner pour chaque jeu de données ;
– la gestion de champs scalaires mutliples associés à un même nuage de points (comme des distances typique-

ment). Ces champs scalaires peuvent être affichés par coloration dynamique des points. Ils peuvent permettre
aussi de moduler l’affichage de l’entité (par filtrage des points associés à certaines valeurs) ou encore de seg-
menter le nuage associé. Plus généralement, ils servent d’entrée à de nombreux alogrithmes, ils peuvent être
composés ensembles, etc.

– enfin, plusieurs types de rendus évolués (soit temps réel via des shaders ou offline via un calcul de Portion de
Ciel Visible par exemple) permettent une forte amélioration de la lisibilité des données 3D à l’écran.

Il est enfin important de noter que bien que CloudCompare soit capable de gérer des maillages triangulaires,
ce type d’entité reste avant tout pour CloudCompare un nuage de points (les sommets du maillage) muni d’une
structure particulière (des triangles), à côté de nombreuses autres structures (octree, kd-tree, couleurs, normales,
champs scalaires, photos calibrées, etc.). L’utilisateur est donc invité à toujours garder cette particularité à l’esprit
lorsqu’il utilise CloudCompare, et il devra en particulier toujours faire attention au rôle de chaque entité 3D dans les
traitements proposés par ce logiciel.

0.2 Licence

Le logiciel CloudCompare est constitué de plusieurs composants logiciels :
– La librairie CClib (algorithmes)
– La librairie qCC_db (base de données)
– Le programme qCC qui utilise ces librairies

Installer et utiliser ces composants signifie que vous acceptez les termes et les conditions de leurs licences respec-
tives. La version 2.4 et les versions antérieures de ces deux composants logiciels sont la propriété d’EDF R&D et de
TELECOM ParisTech.

Licence de la librairie CClib :
La librairie CClib est diffusée sous la licence GNU LGPL (GNU Lesser General Public Licence) telle qu’elle a été
publiée par la FSF (Free Software Foundation) ici : http ://www.gnu.org/licenses/lgpl.html

Licence de la librairie qCC_db :
La librairie qCC_db est diffusée sous la licence GNU GPL (GNU General Public Licence) telle qu’elle a été publiée
par la FSF (Free Software Foundation) ici : http ://www.gnu.org/licenses/gpl.html

Licence du programme exécutable qCC :
Le programme qCC est diffusé sous la licence GNU GPL (GNU General Public Licence) tel qu’elle a été publiée par
la FSF (Free Software Foundation) ici : http ://www.gnu.org/licenses/gpl.html

EDF R&D et TELECOM ParisTech accordent à l’utilisateur les droits d’installer et d’utiliser le logiciel CloudCom-
pare après l’avoir téléchargé depuis le site http ://www.danielgm.net/cc. Le logiciel CloudCompare est fourni en l’état,
sans aucune garantie explicite ou implicite. Les auteurs déclinent toute responsabilité pour tout dommage direct ou
indirect. L’utilisateur assume tous les risques et responsabilités quant à la qualité du logiciel CloudCompare et de
son utilisation.

http://www.gnu.org/licenses/lgpl.html
http://www.gnu.org/licenses/gpl.html
http://www.gnu.org/licenses/gpl.html
http://www.danielgm.net/cc
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0.3 Installation du binaire (Windows)

CloudCompare fonctionne sous les systèmes d’exploitation Windows (XP, Vista & Seven) et Linux (Debian,
Ubuntu, etc.) et pour des architectures 32 ou 64 bits.

Les versions binaires de CloudCompare pour Windows téléchargeables sur le site officiel ne comportent pas de
programme d’installation. Il suffit de décompresser l’archive .zip contenant l’exécutable et les DLLs.
Voici la liste minimale des fichiers que vous devez trouver après décompression de l’archive :

– qCC.exe (exécutable principal)
– history.txt (l’historique des modifications)
– license.txt (la license d’utilisation)
– CC_DLL.dll (librairie CClib)
– QCC_DB_DLL.dll (librairie qCC_db)
– QtCore4.dll (DLL Qt - qt.nokia.com)
– QtGui4.dll (DLL Qt - qt.nokia.com)
– QtOpenGL4.dll (DLL Qt - qt.nokia.com)

Et de manière optionnelle :
– un certain nombre de DLLs supplémentaires nécessaires à certains plugins (freenect.dll, etc.) ou à la prise en

charge de formats de fichiers (liblas.dll, etc.)
– un sous-répertoire plugins contenant les DLLs de chaque plugin
– un sous-répertoire shaders contenant les fichiers requis par certains plugins
– un sous-répertoire imageformats contenant les librairies nécessaires à la lecture et l’écriture de fichiers images

Sous Linux, il faut impérativement compiler le projet pour l’utiliser (voir ci-dessous).

0.4 Compilation du projet

L’intégralité du code de CloudCompare est écrite en C++. Le projet utilise désormais le générateur de projets de
compilation CMake (http ://www.cmake.org).

Pour compiler le projet, référez vous au wiki : http ://www.danielgm.net/cc/doc/wiki

http://qt.nokia.com
http://qt.nokia.com
http://qt.nokia.com
http://www.cmake.org/
http://www.danielgm.net/cc/doc/wiki
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Chapitre 1

Interface

1.1 Fenêtre principale

La fenêtre principale de CloudCompare est constituée des éléments suivants :

1 : Barre de menus de l’application
Cette barre permet d’accéder à la majorité des fonctions de CloudCompare ainsi qu’aux paramètres de l’application
et à divers outils de gestion de l’interfaçe graphique. En fonction des objets sélectionnés, certains des menus ou
sous-menus ne sont pas accessibles (par exemple, les menus « Edit » et « Tools » restent inactifs tant qu’aucun ob-
jet n’est sélectionné et le sous-menu « Scalar fields » du menu « Edit » ne sera accessible que si l’entité sélectionnée
possède au moins un champ scalaire).

2-5 : Barres d’outils
Les différentes icônes de ces barres permettent d’accéder rapidement aux fonctions principales de CloudCompare.
Ces fonctions sont généralement aussi accessibles via les menus situés au dessus (voir 1) mis à part les deux
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outils de modifiation interfactive des entités 3D (segmentation et transformation) et certains outils de modification de
l’affichage 3D (zoom, centre de rotation, points de vue prédéfinis, etc.).

– la barre 2 (Main tools) contient des icônes des fonctions de traitement des entités 3D.
– la barre 3 (Scalar field tools) contient des icônes de fonctions de traitement des champs scalaires.
– la barre 4 (Plugins) contient les icônes des plugins. La première partie est consacrée aux plugins de type

OpenGL filters (shaders) et la seconde aux plugins standards (algorithmes). Cette barre est remplie dynami-
quement en fonction des plugins chargés par le programme au lancement.

– la barre 5 (Viewing tools) permet de modifier les paramètres de visualisation 3D.

Toutes ces barres sont déplaçables (par glisser-déplacer ou drag & drop en anglais). Leur visibilité peut être modifiée
via le sous-menu « Display > Toolbars ».

6 : Arbre de navigation
Dans cette zone apparaît une représentation graphique de la base de données actuellement en mémoire. Elle per-
met de visualiser sous forme d’arborescence l’ensemble des entités chargées ou créées par l’application (voir section
1.2.1). Il est notamment possible de sélectionner une ou plusieurs entités en cliquant sur leur nom dans cet arbre
(l’autre manière de sélectionner des entités est de cliquer sur leur représentation dans la vue 3D associée - voir 8).
Lorsque une entité est sélectionnée, des informations et options sont affichées dans la vue 7 (voir ci-dessous).

7 : Fenêtre de propriétés
Si une seule entité est sélectionnée, cette vue contient des informations et certaines options d’affichage notamment
(voir section 1.4).

8 : Vues 3D
Ces vues permettent de visualiser en trois dimensions les entités géométriques (nuages, maillages, etc.). Cloud-
Compare offre la possibilité de créer plusieures vues 3D à la fois. Ces vues peuvent être gérées via le menu dédié
« 3D Views ». Chaque entité peut-être affectée à une vue 3D particulière via ses propriétés (voir la liste déroulante
Current Display des propriétés communes en section 1.4.1).

9 : console
Cette zone contient l’historique des informations liées à l’exécution de CloudCompare (typiquement des informations
supplémentaires non estentielles délivrées par les algorithmes). Elle peut être affichée ou masqué via la commande
Console du menu « Display » (raccourci clavier : F8).

Dans la suite de cette section, nous allons détailler les fonctionnalités relatives à la manipulation et à la visualisa-
tion des différentes entités de la base de données de CloudCompare. L’utilisateur pourra se référer directement au
chapitre suivant (Chapitre 2) pour obtenir des informations détaillées sur les fonctions et algorithmes applicables à
ces entités.

1.2 Base de données

1.2.1 Arbre de navigation

Comme nous l’avons vu précédemment, CloudCompare affiche l’ensemble des entités disponibles (chargées ou
créees par l’application) dans l’arbre de navigation qui se trouve par défaut dans la partie supérieure gauche de la
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fenêtre principale.

On peut y trouver les éléments suivants :
Un groupe d’entités. Cet élément peut correspondre par exemple à un fichier ouvert (auquel cas il contient
toutes les entités chargées à partir de ce fichier). Il peut aussi être créé et peuplé manuellement (voir plus
bas).
Un nuage de points.

Un maillage triangulaire simple.
Un ensemble de maillages triangulaires partageant les mêmes sommets (qui sont alors contenus dans un
seul nuage de points, qu’on retrouve toujours plus bas dans l’arborescence sous le nom « vertices »).
Une structure de type octree.

Un objet de type capteur laser terrestre.

Une photo non calibrée.

Une photo calibrée.

Une étiquette 2D standard (associée à un ou plusieurs point).

Une étiquette zone 2D (associée à un point de vue).

Un tableau de données partagé par plusieurs entités (des normales par exemple).

Un ensemble de matériaux (généralement associé à un ou plusieurs maillages).

Un point de vue 3D (avec les paramètres de visualisation associés).

De manière classique, l’arborescence peut être développée ou repliée en cliquant respectivement sur les boutons
et situés à gauche des jonctions de l’arbre.

La case à cocher située à gauche du nom d’un élément permet elle d’activer ou de désactiver la branche de
l’arbre qui en part. La notion de désactivation est plus forte qu’un simple affichage/masquage de l’entité (toute entité
affichable dans une vue 3D possède une propriété générique Visible qui permet de gérer ceci - voir plus loin). La
désactivation d’une entité s’applique à l’entité elle-même et à toutes les entités qui lui sont ratachées dans l’arbore-
sence). Ces entités ne sont pas affichées et ne sont pas non plus concernées par certaines opérations (comme la
segmentation graphique interactive, voir section1.5.1).

Remarque : les groupes d’entités sont juste des conteneurs. Ils n’aggrégent pas les caractéristiques des éléments
qu’ils contiennent (un groupe de nuage n’est pas considéré comme un nuage). Typiquement, un groupe ne peut pas
être utilisé comme entrée pour les fonctions de CloudCompare : il ne sert que de classeur.

1.2.2 Sélectionner des entités

Pour sélectionner une entité, deux possibilités s’offrent à l’utilisateur : cliquer avec le bouton gauche de la souris
soit sur l’entrée correspodante dans l’arbre de navigation, soit sur sa représentation dans la vue 3D (ceci est vraie
pour certaines entités seulement : nuages, maillages et étiquettes 2D). Dans les deux cas, l’entrée correspondante
dans l’arbre de navigation apparaît surlignée et l’entité est entourée d’une boîte englobante dans la vue 3D où ap-
paraît l’entité. Lorsqu’un élément est sélectionné, les informations qui s’y rapportent apparaissent dans la fenêtre de
propriétés (voir section 1.4).

Il est possible de sélectionner plusieurs entités en ayant recours aux méthodes classiques de sélection multiple :
– sélection des entités une par une en cliquant dessus (dans l’arbre de navigation ou dans une vue 3D) tout en

maintenant la touche CTRL enfoncée. Pour dé-sélectionner un objet tout en conservant ceux qui ont déjà été
sélectionnés, il faut cliquer une nouvelle fois dessus tout en maintenant la touche CTRL enfoncée.

– sélection d’une série continue d’entités avec la touche MAJ (dans l’arbre de navigation uniquement) : sélection-
ner la première entité, presser et maintenir la touche MAJ enfoncée tout en sélectionnant la dernière entité.
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– toujours dans l’arbre de navigation, on peut enfin survoler les objets à sélectionner en maintenant le bouton
gauche de la souris enfoncé.

La plupart des fonctions de CloudCompare ne s’appliquent qu’aux entités sélectionnées. Les entrées des menus
correspondantes ne sont d’ailleurs actives que lorsque l’utilisateur a sélectionné le type et le nombre d’entités appro-
priés (par exemple, deux nuages ou un nuage et un maillage pour le calcul de distances).

1.2.3 Intéractions avancées avec l’arbre de navigation

Il est possible de déplacer les entités dans l’arbre de navigation par drag & drop (pour les regrouper dans un
même « groupe » par exemple). Les « groupes » sont crées automatiquement lors du chargement depuis un fichier
(auquel cas le groupe prend le nom du fichier) mais ils peuvent aussi être créés par clic sur un élément de l’arbre de
navigation (ou dans une partie vide pour créer le groupe à la racine).

Attention : déplacer ainsi les entités change leurs relations hiérarchiques (ce qui peut avoir des conséquences
importantes lors de certaines actions, comme la sauvegarde ou la suppression de l’entité parente). De plus les enti-
tés ne peuvent pas être déplacées n’importe où pour maintenir la cohérence interne de la base de données.

Un clic droit sur un élément de l’arbre de navigation fait apparaitre un menu contextuel (dont le contenu dépend
de l’entité). On retrouve toujours les entrées suivantes :

– Toggle - inverse l’état d’activation de l’entité
– Delete - supprime l’entité
– Add empty group - rajoute un « groupe » (sous l’entité)

Si l’entité est affichable en 3D (nuage, maillage, étiquette 2D, etc.), des options supplémentaires permettent
d’inverser l’état de visibilité de l’entité elle-même et de ses composantes éventuelles (couleurs, normales, champ
scalaire, etc.).

Enfin, si l’entité possède plusieurs sous-entités dans l’arbre, des options permettant la réorganisation de ces
sous-entités peuvent apparaitre (tri automatique par nom, ou tri par type).

1.2.4 Entités particulières

1.2.4.1 L’octree

L’octree est une structure destinée à accélérer les traitements sur des données spatiales. Il s’agit d’un découpage
récursif et hiérarchique de l’espace (en cubes). CloudCompare associe les nuages de points avec une telle structure
dans de très nombreux cas pour accélerer ses traitements. C’est un type d’octree particulier qui est particulièrement
rapide à construire, et optimisé pour la recherche de plus proches voisins (ce n’est par contre pas un octree efficace
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pour l’affichage de type L.O.D. - level of detail - typiquement).

D’un point de vue général, l’octree est défini par niveaux de subdivison :
– Le premier niveau (niveau 0) est le plus petit cube englobant entièrement le nuage de points (une version

cubifiée de la boite englobante).
– Au niveau N+1, l’octree est construit en subdivisant chacun des cubes du niveau N en 8 sous-cubes de même

taille (en pratique on ne se souvient que des sous-cubes contenant au moins un point).

Il n’est pas inintéressant pour l’utilisateur de comprendre le principe de cette structure, puisqu’elle occupe une
place centrale dans CloudCompare.

Plus le niveau d’octree est élevé :
– plus le nombre de cubes à traiter est élevé : potentiellement 8N = 23N cubes au niveau N . Pour un ordre

d’idées, et bien que cela soit très peu probable, on peut donc avoir jusqu’à 221 = 2 097 152 de cubes au niveau
7 de l’octree. Au niveau 10, on a 230 cubes, soit un peu plus d’un milliard ! (là encore, cela est extrêmement peu
probable ... d’autant plus qu’il faudrait au moins autant de points). En pratique, beaucoup de cubes sont vides
et ne sont donc pas conservés en mémoire, d’où une structure généralement beaucoup plus compacte. Enfin,
CloudCompare utilise un codage spécial de l’octree qui fait que sa taille est toujours égale au nombre de points
du nuage, et ne dépend donc pas de la répartition spatiale de celui-ci. C’est aussi pour cette raison que le
niveau maximal d’un octree est fixé à 10 dans la version actuelle de CloudCompare (ce qui permet de
coder la position de chaque point et pour tous les niveaux de l’octree sur 3*10 = 30 bits, ce qui tient dans une
valeur entière de 4 octets = 32 bits, soit un codage par point pas trop gourmand en mémoire).

– plus les cubes sont petits : si aN est la taille d’une arête du cube au niveau N (donc a0 est la taille du cube
initial), aN = a0

2N
. En effet, par construction, on divise par deux la taille des cubes selon chaque dimension

lorsque l’on descend d’un niveau. Par exemple, les cellules de l’octree au niveau 5 d’un octree sont 32 fois plus
petites que la cellule initiale englobant tout le nuage (au niveau 0).

– plus le nombre de points par cube est faible : intuitivement, les cubes étant plus petits, ils contiennent (statisti-
quement) moins de points.

– plus l’enveloppe de l’octree (la surface globale qui serait formée par l’ensemble des surfaces externes des
cubes) est proche du nuage de points originale.

FIGURE 1.1 – Cellules à différents niveaux d’octree : niveau 1 (gauche), 3 (milieu) et 6 (droite).

Les 3 captures d’écran de la figure 1.1 donnent un aperçu de la répartition et de la taille des cellules d’octree à
differents niveaux de subdivision.

Beaucoup de traitements sur les nuages de points ont recours à un octree. Lorsque cela est possible, le niveau
d’octree optimal pour les calculs à effectuer est déterminé de manière automatique par CloudCompare. Toutefois,
certains algorithmes peuvent demander à l’utilisateur de spécifier un niveau spcifique à utiliser. Dans ces situations,
il s’agit généralement pour l’utilisateur de trouver un niveau qui aboutisse au meilleur compromis entre le nombre de
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cubes à traiter (qu’on ne veut généralement pas trop grand, donc une valeur de niveau pas trop élevée) et le nombre
moyen de points par cube (qu’on ne veut généralement le plus petit possible, donc une valeur de niveau ... pas trop
faible). Trouver le bon niveau peut parfois nécessiter une certaine expérience.

1.2.4.2 Etiquettes 2D et annotation graphique

CloudCompare permet d’annoter un ensemble d’entités 3D via des étiquettes (2D labels) de différents types.

Remarque : ces étiquettes peuvent être sauvées via le format binaire propre à CloudCompare (BIN).

Etiquette standard

FIGURE 1.2 – Etiquettes standards

Le premier type, 2D label, correspond aux étiquettes (mobiles) rattachées à un ou plusieurs points :
– un point : l’étiquette continent les coordonnées du point, son indice dans le nuage et les valeurs de ses différents

champs (couleur, normale, champ scalaire affiché)
– deux points (segment) : l’étiquette contient les coordonnées de chaque point et leur indice respectif dans le(s)

nuage(s) ainsi que la distance entre les deux points
– trois points (triangle) : l’étiquette contient les coordonnées de chaque point et leur indice respectif dans le(s)

nuage(s), l’aire du triangle ainsi défini, la normale au triangle, et enfin l’angle au niveau du premier point (l’ordre
de sélection des points est donc important)

La représentation graphique des étiquettes standards peut être modulée en fonction des besoins : leur titre peut
être affiché en 3D à côté du ou des points auxquelles elles sont associées, tandis que leur représentation 2D peut
être soit affichée totalement, soit affichée de manière condensée soit encore cachée. La représentation 2D a de plus
une transparence réglable (via les paramètres d’affichage généraux de CloudCompare - voir section2.4.7). A l’instar
des nuages de points ou les maillages, les étiquettes standards peuvent être sélectionnées à l’écran (sélection mul-
tiple ou individuelle).

Les étiquettes rattachées à un unique point peuvent être créées très facilement (à la volée) par un simple clic sur
le point en maintenant la touche SHIFT enfoncée. Autrement, tous les autres type d’étiquettes peuvent être crées



1.3. AFFICHAGE DES ENTITÉS 11

avec l’outil ’Point Picking’ (Cf. section 2.2.29).

Etiquette zone 2D

FIGURE 1.3 – Etiquettes zone 2D

Le second type d’étiquette, 2D area label, correspond aux étiquettes fixes rattachées à un point de vue. Ce sont
des zones rectangulaires (définies par l’utilisateur à l’écran) associées à un commentaire textuel.

Etant donné que ce qui apparaît dans la zone délimitée par l’étiquette dépend du point de vue (orientation de la
caméra, etc.), l’étiquette n’apparait que lorsque la caméra est dans la même position (et avec les mêmes paramètres)
que lorsqu’elle a été créée (seuls certains paramètres peuvent être compensés automatiquement, comme le zoom
ou le panning en mode orthographique). Pour simplifier la tâche de l’utilisateur, les étiquettes zone 2D sont donc
capables de rétablir ces paramètres dans la vue 3D associée (un bouton Apply se trouve dans les propriétés de
l’étiquette - voir section 1.4.7).

1.3 Affichage des entités

1.3.1 Vues 3D

1.3.1.1 Présentation

Les vues 3D (voir figure 1.4) sont les sous-fenêtres dans lesquelles sont affichées les entités. Elles possèdent
un fond (qui peut-être un dégradé de couleur ou une couleur unique - voir les paramètres d’affichage généraux en
section 2.4.7), par dessus lequel sont affichées les entités 3D (nuages, maillages, etc.) et encore par dessus, des
éléments d’interface ou des entités 2D (étiquettes, échelle de couleur, etc.).

Voici les éléments standards qui composent une vue 3D :
– 1 : les entités 3D, éventuellement encadrées par leur boite englobante 1 si elles sont sélectionnées).
– 2 : l’échelle fournit une référence pour l’estimation des dimensions. Sa longueur est exprimée dans l’unité

impliticte courante (i.e. l’unité implicite des coordonnées de la ou des entités affichées, telles qu’elles ont été
chargées depuis leur fichier d’origine - CloudCompare n’utilise pas d’unité explicite).

1. Aussi appellée bounding-box. Il s’agit du plus petit parallélépipède rectangle aligné avec les axes principaux (X,Y,Z) et qui contienne l’inté-
gralité des entités sélectionnées
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– 3 : le trièdre d’orientation représente l’orientation courante des trois axes principaux : X (rouge), Y (vert) et Z
(bleu).

– 4 : nom du champ scalaire actif et sa rampe de couleurs associée.
– 5 : informations temporaires concernant l’affichage ou l’action en cours. Il peut s’agir de la dimension courante

de la vue 3D (en pixels - après un redimensionnement de la fenêtre), du type de projection utilisé, etc.
– 6 : étiquette 2D standard (ici associée à un point 3D d’un nuage). Ces étiquettes s’affichent toujours par dessus

les objets 3D (leur transparence est réglable). Pour plus d’information, Cf. section1.2.4.2.
– 7 : étiquette zone 2D. Ces étiquettes particulières permettent d’annoter une zone précise de l’écran et sont

donc liées à un point de vue (qu’elles sont capable de rétablir sur demande) et non à une entité.

FIGURE 1.4 – Eléments standards d’une vue 3D

Seuls l’échelle et le trièdre d’orientation sont visibles en permanence. Les autres informations dépendent de l’état
courant de l’application.

1.3.1.2 Interagir avec une vue 3D

Vous pouvez intéragir avec une vue 3D en utilisant la souris (figure 1.5) :

– L - clic gauche court : [SELECTION] cliquez sur un objet dans la vue 3D pour le sélectionner.
– L - clic gauche maintenu : [ROTATION] maintenez le bouton gauche de la souris enfoncé et déplacez la souris

pour effectuer une rotation du point de vue autour du pivot courant (cf. sections 2.4.4 et 2.4.5 ou encore les
paramètres caméras en section 2.4.8 ou enfin l’outil de picking du centre de rotation en section 1.3.2).

– M - roulement : [ZOOM] faites rouler la molette vers l’avant (ou vers « le haut ») pour effectuer un zoom positif
dans la vue 3D et inversement, faites rouler la molette vers l’arrière (ou « le bas ») pour effectuer un zoom
négatif.

– R - clic droit court : sur les étiquettes 2D, un clic droit court permet de la condenser ou inversement de rétablir
son extension maximale.
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FIGURE 1.5 – Commandes via la souris (L : [SELECTION/ROTATION], M : [ZOOM], R : [PAN])

– R - clic droit maintenu : [PANNING] maintenez le bouton droit de la souris enfoncé et déplacez la souris pour
effectuer une translation du point de vue dans le plan écran.

Par défaut, la visualisation se fait selon une projection orthographique (sans perspective) et le centre de rotation
est positionné sur le centre de la boite englobant toutes les entités affichées dans la vue 3D. Lors du changement
de point de vue (rotation, translation), les gros nuages de points ou les gros maillages sont temporairement sous
échantillonnés de manière à permettre le rendu interactif des mouvements (ce comportement est paramètrable - voir
section2.4.7).

1.3.1.3 Utiliser plusieurs vues 3D

Dans CloudCompare, un nombre quelconque de vues 3D peut être créé, et chaque entité peut être assignée
séparémment à une vue 3D particulière.

Pour créer une nouvelle vue 3D, cliquez sur la commande New dans le menu « 3D views », ou utilisez le raccourci
clavier CTRL+F3. Une nouvelle fenêtre apparaît alors (par défaut elle sera maximisée).

Pour partager l’espace d’affichage entre les différentes vues 3D, différents choix s’offrent à l’utilisateur :
– Tile (partitionnement) : chaque fenêtre occupe une portion "équivalente de l’espace disponible, les fenêtres ne

se chevauchent pas.
– Cascade : chaque fenêtre occupe la même portion d’espace prédéfinie, elles sont décalées de manière régu-

lière en se chevauchant.
– redimensionnement manuel : de manière classique chaque vue 3D peut-être déplacée et redimensionnée, en

s’aidant notamment des boutons (minimiser la vue) et (réduire la vue) disponibles en haut à droite de
chaque fenêtre.

Il est aussi possible de naviguer entre les différentes vues via les commandes Next et Previous du menu « 3D
views », ou en accédant directement à la vue désirée en cliquant sur son nom dans ce même menu.

Pour fermer une vue 3D, utilisez l’entrée Close du menu « 3D views » (après avoir activé cette fenêtre en cliquant

dessus) ou plus simplement utilisez le bouton de la fenêtre.

Enfin, pour changer la vue 3D dans laquelle une entité apparaît, sélectionnez cette entité puis modifiez la valeur
courante de la liste déroulante Current Display dans la fenêtre de propriétés.
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Remarque : il est possible de n’afficher une entité dans aucune vue 3D en choisissant None comme contexte de
destination.

1.3.1.4 Camera link

Les vues 3D sont indépendantes les unes des autres, et les changements de point de vue dans une vue 3D
particulière n’ont a priori aucune répercussion sur les autres vues 3D. Toutefois, il est possible de synchroniser les
mouvements de caméra pour qu’ils soient appliqués à toutes les vues 3D en même temps. Pour ce faire il suffit de
cocher l’option Camera link située juste sous l’arbre de navigation.

1.3.2 Options d’affichage

1.3.2.1 Barre d’outils Viewing Tools

Un certain nombre d’icônes et d’outils permettent à l’utilisateur de contrôler l’affichage courant. La majeure partie
d’entre eux sont accessibles via la barre d’outils Viewing tools :

Changer les paramètres d’affichage généraux (couleurs, matériaux, taille de la police, précision numérique
des valeurs affichées, etc. - voir section2.4.7).
Changer les paramètres de caméra de la fenêtre 3D courante (orientation et centre de rotation, etc. - voir
section2.4.8).
Zoomer et recentrer la caméra pour rendre visibles toutes les entités affichées dans la vue 3D courante.

Sélection du centre de rotation par picking d’un point à l’écran.

Zoomer et recentrer la caméra sur la ou les entités sélectionnées. Aucun effet si aucun objet n’est sélectionné.
Les 6 derniers boutons permettent de basculer entre différents points de vue prédéfinis (dans l’ordre où les
boutons apparaissent : haut, avant, gauche, arrière, droit, bas). Ces points de vue sont définis par rapport au
trièdre d’orientation.
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1.3.2.2 Menu Display

D’autres fonctionnalités relatives à l’affichage sont accessibles via le menu Display :
– Full screen : basculer la fenêtre principale entre l’affichage standard et l’affichage plein écran (raccourci clavier :

F11).
– Refresh : forcer l’actualisation de l’affichage (raccourci clavier : F5).
– Test frame rate : lancer un test d’estimation du taux de rafraîchissement (exprimé en ’f.p.s’ = frame per second

ou images par seconde en français) pour la vue 3D courante. En théorie, plus il y a de triangles ou de points à
afficher, plus le taux de rafraîchissement devrait être faible. Il est admis qu’en deçà d’une vingtaine d’images par
seconde, l’humain perçoit l’affichage comme étant saccadé (au delà de 24 f.p.s, l’affichage est perçu comme
étant fluide).

– Toggle centered perspective : basculer entre la projection par défaut (parallèle orthographique) et la projection
perspective avec le centre de rotation de la caméra placé par défaut sur le centre de la boite englobant toutes
les entités affichées (raccourci clavier : F3).

– Toggle viewer based perspective : basculer entre la projection par défaut (parallèle orthographique) et la pro-
jection perspective avec le centre de rotation de la caméra placé par défaut en son centre optique (l’oeil virtuel
de l’utilisateur) (raccourci clavier : F4).

– Light > Toggle sun light : activer ou désactiver la lumière globale (raccourci clavier : F6).
– Light > Toggle custom light : activer ou désactiver la lumière personnalisée (raccourci clavier : F7). Cette source

de lumière peut être déplaçée en maintenant la touche CTRL enfoncée tout en faisant un pan avec la souris à
l’écran - voir section1.3.1.2).

Remarque : les effets d’ombrage permis par les normales d’un nuage ou d’un maillage ne sont visibles que si au
moins une source lumineuse est active.

1.3.2.3 Taille des points 3D

La taille des points affichés dans une vue 3D est modifiable via des interacteurs qui apparaissent directement en
surimpression de la vue lorsque la souris survole son coin haut-gauche.

Pour modifier la taille d’affichage des points, il suffit de cliquer sur ’-’ ou ’+’. Un point de référence à la taille cou-
rante apparaît entre les deux interacteurs.

1.4 Fenêtre de propriétés

La fenêtre de propriétés contient toutes les informations sur l’entité sélectionnée, ainsi que des options modifiables
par l’utilisateur (visiblité de certains composants, etc.).

1.4.1 Propriétés communes des entités affichables

Certains champs sont communs à (presque) toutes les entités affichables. On les retrouve dans la section CC
Object :
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– Name : nom de l’entité. Il peut être modifié en cliquant sur l’entrée correspondant à l’entité dans l’arbre de
navigation (voir 1.2.1) ou encore en utilisant le raccourci clavier F2.

– Unique ID : toutes les entités CloudCompare sont représentées en interne par un identifiant unique.
– Children : le nombre de sous-éléments (ou enfants) rattachés à cette entité. Dans la capture ci-dessus par

exemple, l’objet sélectionné est un groupe de maillages regroupant 758 sous-maillages, un nuage de points et
un tableau de normales compressées, soit 760 sous-entités au total).

– Visible : spécifie si l’entité doit être affichée dans la vue 3D associée ou non. La propriété ’Visible’ n’est pas
héréditaire (contrairement à l’état d’activation de l’entité, qui correspond à la case à cocher présente au niveau
de l’arbre de navigation et qui concerne toutes les entités présentes dans le reste de la branche). Si l’entité est
sélectionnée, la boite englobante reste visible même si la propriété Visible est désactivée.

– Colors (optionnelle) : si l’entité sélectionnée possède des couleurs, une case à cocher Colors apparait ici. Elle
permet de spécifier si ces couleurs doivent être utilisées lors de l’affichage de l’entité ou non. Remarque : la
propriété Scalar field (voir ci-dessous) est toujours prioritaire par rapport à Colors.

– Normals (optionnelle) : si l’entité sélectionnée possède des normales, une case à cocher Normals apparait ici.
Elle permet de spécifier si ces normales doivent être utilisées lors de l’affichage de l’entité ou non. Les normales
permettent d’obtenir un rendu visuel semi-réaliste des objets en faisant varier la teinte des points ou facettes
associéess en fonction de la position de l’éclairage. Si les normales sont désactivées, la surface de l’objet est
affichée dans une couleur uniforme (effet « silhouette », avec une perte de la perception des profondeurs). Le
plugin qEDL (voir section??) est une excellente alternative aux normales. Il simule en temps réel un éclairage
encore plus réaliste, sans information autre que la position des points ou des objets.

– Scalar field (optionnelle) : si l’entité sélectionnée possède un ou plusieurs champs scalaires, une case à cocher
Scalar field apparait ici. Elle permet de spécifier si le champ scalaire couramment affiché (voir la liste déroulante
Current dans la section Scalar field des proprités) doit être utilisé lors de l’affichage de l’entité ou non. Si un
champ scalaire courant est défini dans la liste déroulante Current, alors ce champ scalaire sera toujours affiché
en priorité par rapport aux éventuelles couleurs de l’entité.

– Current display : cette liste déroulante permet de choisir la vue 3D dans laquelle l’objet sera affiché (cf. section
1.3.1.3).

– Box dimensions : les dimensions de la boite englobante de l’entité.
– Box center : le centre de la boite englobante de l’entité.

1.4.2 Propriétés propres aux nuages de points

La section Cloud est réservée aux nuages de points. Elle contient les champs suivants :
– Points : le nombre de points du nuage.
– Global shift : la translation qui a été éventuellement appliquée au chargement du nuage par CloudCompare

(généralement pour rammener ses coordonnées à des valeurs compatibles avec un stockage en flottant sur
32 bits). C’est typiquement le cas des nuages exprimés dans des systèmes de coordonnées à l’échelle d’un
pays (UTM, etc.), avec des valeurs dépassant les millions. Dans ce cas, CloudCompare propose à l’utilisateur
de recentrer automatiquement l’entité. Cette translation est conservée tout au long de la vie de l’entité puis elle
sera éventuellement ré-appliquée aux points lors la sauvegarde de l’entité (si le format le permet).
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1.4.3 Propriétés propres aux maillages ou groupes de maillages

Les entités maillages ou groups de maillages deux types d’entités partagent les mêmes propriétés :
– Faces : le nombre de facettes composant le maillage. Dans le cas d’un groupe de maillages, ce nombre cor-

respond au nombre total de facettes de tous les sous-maillages rattachés à ce groupe.
– Wireframe : permet d’activer le rendu en « fil de fer » du maillage (seules les arrêtes des triangles sont affichées

et non l’intérieur - voir figure 1.6).

FIGURE 1.6 – Exemple de rendu en fil de fer d’un maillage

1.4.4 Propriétés communes aux nuages et maillages

1.4.4.1 Champs scalaires (Scalar fields)

Certains traitements effectués sur les nuages de points permettent d’associer à chaque point une valeur numé-
rique (un scalaire). L’ensemble de ces valeurs scalaires constitue une structure appelée Champ Scalaire (ou Scalar
field). Les champs scalaires sont toujours rattachés à un nuage de points. Néanmoins, pour une meilleure ergonomie,
les maillages dont les sommets portent des champs scalaires se comportent comme s’ils portaient eux-même ces
champs scalaires (ils sont d’ailleurs aussi capables de les utiliser lors de leur affichage 3D). Les propriétés propres
à ces champs scalaires apparaissent donc de la même manière au niveau d’un nuage de point qu’au niveau d’un
maillage dont les sommets portent un champ scalaire.
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Il est possible de rattacher plusieurs champs scalaires à un même nuage, mais un seul peut être actif (i.e. affiché)
à un instant donné. Le nombre de champs scalaires associés à une entité correspond d’ailleurs à la première entrée
(Number ) de la section Scalar Field.

En dessous se trouve une liste déroulante (Current) permettant de spécifier le champ scalaire actif. Chaque
champ scalaire à un nom unique. Celui-ci peut-être modifié par l’utilisateur via la commande « Edit > Scalar fields >
Rename » (Cf. section2.2.27).

Ensuite vient l’entrée Color ramp permettant de choisir la rampe de couleur utilisée pour l’affichage du champ
scalaire sous forme de fausses couleurs (voir la section suivante pour plus de détails). Elle est suivie de l’entrée
Color ramp steps qui permet de spécifier le nombre de couleurs différentes utilisées pour l’affichage en fausses
couleurs. Par exemple, utiliser un nombre très faible de couleurs sur une entité dense permet d’obtenir un effet lignes
de niveau.

Enfin, la dernière entrée de la section Scalar Field est la case à cocher Postive qui permet de spécifier si le champ
scalaire doit être considéré comme strictement positif (auquel cas toutes les valeurs négatives sont considérées
comme étant des valeurs invalides, de type NaN = not a number ). Sinon, CloudCompare considère toutes les valeurs
comme étant valides. Cette propriété influe directement sur la manière dont la correspondance valeur scalaire -
couleur est calculée (voir ci-dessous).

1.4.4.2 Rampe de couleurs (SF Scale)

La section SF Scale est consacrée à l’affichage du champ scalaire actif en fausses couleurs. Elle est en pratique
toujours présente si un champ scalaire est activé (i.e. sélectionné dans la liste déroulante Current - voir ci-dessus).

Différentes rampes de couleurs (ou encore échelles de couleurs) sont disponibles. Chacune correspond à un
dégradé de couleurs, la première couleur étant associée à la valeur minimale de saturation du champ scalaire et la
dernière couleur à la valeur maximale de saturation. Les couleurs intermédiaires sont associées aux valeur scalaires
équivalentes de manière linéaire.

Remarque : dans le cas d’un champ scalaire non strictement positif, il est possible de spécifier une échelle de
couleur avec saturation absolue, auquel cas l’échelle de couleur courante est coupée en deux et est utilisée de
manière symétrique pour les valeurs négatives ou positives (voir plus bas).
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valeur minimale valeur maximale
Bleu à rouge :

Niveaux de gris :

Rouge à jaune :

Rouge à blanc :

CloudCompare permet à l’utilisateur de paramétrer finement la manière dont les valeurs du champ scalaire
courant sont affichées en fausses couleurs (et ce de manière dynamique). Quatre valeurs clés sont modifiables
interactivement :

– 1 : Valeur minimale affichée (min displayed value). Toutes les valeurs scalaires inférieures sont ignorées (et
sont alors considérées comme étant de type NaN - voir plus bas).

– 2 : Valeur minimale de saturation (min saturation value). Tous les valeurs inférieures (et donc comprises entre
min displayed et min saturation) sont affichées avec la (même) couleur, « la plus faible » de la rampe (ici en
bleu).

– 3 : Valeur maximale de saturation (max saturation value). Tous les valeurs supérieures (et donc comprises
entre max saturation et max displayed) sont affichées avec la (même) couleur, « la plus forte » de la rampe (ici
en rouge).

– 4 : Valeur maximale affichée (max displayed value). Toutes les valeurs scalaires supérieures sont ignorées (et
sont alors considérées comme étant de type NaN - voir plus bas).

La manière dont sont traitées les valeurs de type NaN (valeurs invalides ou volontairement ignorées par l’utilisa-
teur via le réglagle des valeurs min displayed (1) et max displayed) (4) se règle via la case à cocher Nan in grey.
Si celle-ci est cochée, les points associés à ces valeurs scalaires sont affichés avec une couleur grise par défault.
Sinon ces points ne sont pas affichés.

Les quatre valeurs clés présentées précédemment permettent donc de définir plusieurs plages :
– les valeurs affichables, pour lesquelles les points sont effectivement affichés en fausses couleurs. Le compor-

tement en dehors de cette plage dépend de la propriété Nan in grey.
– la plage de saturation, en dehors de laquelle la variation des couleurs est désactivée. La borne inférieure de

cet intervalle est associée à la première couleur de l’échelle, la borne supérieure à la dernière couleur, et le
reste des couleurs est réparti linéairement entre ces bornes.

CloudCompare vérifie en permanence la cohérence des valeurs saisies : on ne peut pas avoir (1)> (4) ni (2)> (3).
Toute modification valide d’une de ces valeurs est immédiatement répercutée sur l’affichage, de manière interac-
tive.Par défaut les valeurs de saturation ne peuvent donc pas sortir des bornes ’min displayed value’ (1) et ’max
displayed value’ (4), et ces bornes sont imposées par les données elles-même (CloudCompare calcule automatique-
ment ces bornes à partir des valeurs effectives du champ scalaire). Or, il arrive que pour des raisons esthétiques
ou pratiques l’utilisateur veuille voir apparaitre des bornes différentes (en particulier au niveau de la représentation
graphique de l’échelle de couleur dans la vue 3D), ou une saturation qui commence par exemple à partir de 0 dans
tous les cas de figure. Il existe donc la propriété release boundaries qui permet une fois activée de modifier manuelle-
ment les bornes ’min displayed’ et ’max displayed’ (il suffit pour cela de modifier manuellement les valeurs textuelles
correspondantes en les remplaçants par les nouvelles bornes désirées).
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D’autres options sont disponibles :
– l’option log scale permet d’afficher les fausses couleurs (et les valeurs textuelles correspondantes à l’écran)

selon une échelle logarithmique.
– comme évoqué plus haut, dans le cas d’un champ scalaire non strictement positif, une option absolute satu-

ration apparait. Si l’utlisateur la coche, alors les valeurs ’min staturation’ (2) et ’max saturation’ (3) changent
de sens : elles deviennent forcément positives et concernent à la fois les valeurs négatives et les valeurs po-
sitives (par symétrie). La variation automatique des couleurs ne se passera donc qu’entre -’max saturation’ et
-’min stauration’ et entre +’min stauration’ et +’max stauration’. Les couleurs stagneront en dessous de -’max
saturation’ (couleur minimale de la rampe - bleu typiquement), entre -’min stauration’ et +’min stauration’ (cou-
leur centrale de la rampe - vert typiquement) et enfin au dessus de +’max saturation’ (couleur maximale de la
rampe - rouge typiquement).

Enfin, la rampe de couleurs avec les valeurs numériques remarquables associées (min, max, valeurs de satura-
tion, etc.) peut être affichée à côté des entités dans la même vue 3D (cf. figure de la section 1.3.1). Il faut cocher la
case display scale en fin de section SF scale. Une seule rampe de couleur peut-être affichée à la fois. De plus, si
l’entité associée est cachée ou désactivée, la rampe de couleur ne sera pas affichée.

1.4.5 Propriété de l’octree

L’octree est indissociable du nuage de points auquel il est rattaché. Il s’agit d’une structure abstraite, disponible
dans l’interface de CloudCompare et affichable uniquement à titre informatif (elle peut aussi être supprimée pour
libérer de la mémoire si besoin). L’affichage de la structure proposé par CloudCompare ne permet de visualiser
qu’un niveau à la fois. Vous pouvez changer le niveau d’affichage de l’octree en incrémentant/décrémentant le champ
Display level de la section Octree.

Les niveaux qui peuvent être affichés vont de 1 à 10. Le niveau 0 ne peut être sélectionné (il n’est dailleurs en
pratique jamais utilisé, pas même pour les calculs, puisque l’octree au niveau 0 correspond ni plus ni moins au nuage
dans son intégralité, contenu dans une unique cellule).

Il se peut que l’affichage ralentisse considérablement au delà d’un certain niveau de subdivision (en fonction des
capacités de l’ordinateur sur lequel le programme s’exécute), à cause du nombre conséquent d’éléments à afficher.

L’octree peut être visualisé sous différentes formes :
– Fil de fer (Wire) : seules les arrêtes des cubes sont représentées (attention : lourd).
– Points : chaque cube est représenté par le centre de gravité des points qui y sont inclus.
– Surfacique (Plain cubes) : la surface des cubes est affichée intégralement (attention : très lourd).

Le mode d’affichage courant de l’octree est controllé par la liste déroulante Display type.

1.4.6 Popriétés des étiquettes standards

Les étiquettes 2D standards sont des étiquettes graphiques qui s’affichent en surimpression de la vue 3D et qui
peuvent être associées à un ou plusieurs points (voir section 1.2.4.2).
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Outre les options standards des objets affichables dans les vues 3D (voir section 1.4.1), ces étiquettes possèdent
plusieurs champs regroupés dans la section Label :

– Body - le corps de l’étiquette (généré automatiquement). Pour information (et pour export, via copier-coller, si
nécessaire).

– Show 2D label - permet de cacher la partie 2D de l’étiquette
– Show 3D legend(s) - permet de cacher la rappel du nom de l’étiquette à côté du ou des points associés en 3D

1.4.7 Popriétés des étiquettes zone 2D

Les étiquettes zone 2D sont des étiquettes graphiques qui s’affichent en surimpression de la vue 3D et qui sont
associée à un point de vue (voir section 1.2.4.2).

Les étiquettes zones 2D, outre leur nom (qui apparaît en dessous du rectangle correspondant à l’étiquette -
ce nom est d’ailleurs modifiable comme pour toute entité) n’ont qu’un bouton Apply dans leurs propriétés. Celui-ci
provoque l’application des paramètres de caméra associés à l’étiquette dans la vue 3D (et donc cela force l’apparition
de l’étiquette, qui ne se dessine à l’écran que si les paramètres de caméra courants coïncident avec ceux de la
caméra lors de la création de l’étiquette).

1.4.8 Popriétés des points de vues

Il est possible à tout moment de sauver le point de vue courant (avec tous les paramètres de visualisation asso-
ciés, comme la taille des points, etc.) via la commande « Display > Save viewport as object » ou le raccourci clavier
Ctrl+V. L’objet correspondant Viewport se comporte exactement comme une étiquette zone (mis à part qu’il n’a pas
de représentation associée).

1.4.9 Popriétés des images

Des images (calibrées ou non) peuvent être associées aux entités 3D. Dans le cas des images calibrées (i.e. pour
lesquelles on dispose de toutes les informations de calibrage intrinsèques et extrinsèques par rapport aux données)
il est possible de les afficher en surimpression de la vue 3D.

Ces images peuvent être importées via les formats E57, ICM ou encore via l’import de fichiers Bundler (OUT).

Les images ont toutes en commun la section Image :
– Width - largeur de l’image (en pixels)
– Height - hauteur de l’image (en pixels)
– Alpha - curseur permettant de régler la transparence (entre 0 et 100%)
La section Calibrated Image est par contre reservée aux images calibrées :
– Apply viewport - change les paramètres de la vue 3D associée à l’image pour coïncider avec ceux de l’appareil
– f.o.v. - field of view ou ouverture angulaire (en degrés)
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FIGURE 1.7 – Vue d’une image calibrée en surimpression d’un nuage

– Optical center - centre optique
– Orientation - direction de visée
– Angle - Angle de rotation autour de l’axe de visée (en degrés)

1.4.10 Popriétés des capteurs laser (terrestres)

Les objets capteurs terrestres (Ground Based Lidar sensor ) ont une représentation in situ symbolique (un cube
sur un trépied). Ils ont aussi une section propre dans la fenêtre de propriétés (section GBL sensor ) :

– dPhi - le pas angulaire selon l’axe de rotation principal (en radians)
– dTheta - le pas angulaire selon l’axe de rotation secondaire (en radians)
– Uncertainty - l’incertitude en profondeur (utilisée lors de la comparaison de nuages de points)
– Display scale - échelle relative de la représentation symbolique

FIGURE 1.8 – Représentation symbolique d’un capteur laser terrestre
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1.5 Modification interactive des entités

1.5.1 Segmentation manuelle

L’outil segmentation manuelle (ou segmentation graphique interactive) est accesible via l’icône de la barre
d’outils supérieure (Main toolbar ). Il permet de "découper" manuellement à l’écran la ou les entités sélectionnées.

Cet outil permet en effet de définir un contour à l’écran (voir figure 1.9), puis de choisir si l’ont veut "garder" les
points ou les triangles présents à l’intérieur ou à l’extérieur de ce contour. Le processus est répétable à volonté, et
les points/triangles rejetés sont cachés au fur et à mesure. Si l’utilisateur valide sa segmentation, les entités sélec-
tionnées sont chacune divisées en deux : une partie correspondant aux points/triangles sélectionnés et l’autre avec
les points/triangles restants.

Note : dans le cas des maillages, les triangles présents sur la frontière du contour ne sont pas découpés à propre-
ment parler (on ne garde que les triangles dont les 3 sommets sont totalement inclus dans la frontière, et les autres
triangles sont considérés comme étant à l’extérieur ).

Deux types de contours sont disponibles :
– contour de type ’polyligne’ : l’utilisateur peut définir les sommets successifs d’une polyligne par clics gauches

successifs à l’écran. Une fois le premier clic effectué, CloudCompare fait apparaitre en temps réel la forme de
la polyligne en suivant le pointeur de la souris comme si celui-ci correspondait à un nouveau sommet. Un clic
droit permet de figer le contour (nécessaire pour effectuer une segmentation - voir ci-dessous). Enfin, tout clic
gauche intervenant après que le contour ait été figé réinitialise celui-ci.

– contour de type ’rectangle’ : ce mode permet de définir des contours rectangulaires à l’écran. Un simple clic
droit permet de définir le premier coin du contour puis un second le coin opposé. Il n’est pas nécessaire de
maintenir le bouton enfonçé entre les deux clics.

FIGURE 1.9 – Outil de segmentation manuelle

En pratique, l’outil s’active dans la vue 3D courante (d’ailleurs seules les entités affichées dans cette vue sont pris
en compte par CloudCompare). L’interface principale de CloudCompare est gelée (la plupart des icônes et menus ne
sont plus accessibles, mis à part les options d’affichage). Celle-ci est rétablie quand l’utilisateur quitte l’outil (dernière
icône à droite en forme de croix rouge).
Une barre d’icônes apparaît dans le coin haut-droit de la vue 3D :
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– la première icône permet de mettre en pause la segmentation (ce qui permet de récupérer le comportement
normal de la souris et de faire tourner les entités 3D entre deux phases de contourage/découpe par exemple).
Attention, si la segmentation est mise en pause, le contour actuellement dessiné disparaît. Et si une segmen-
tation est validée (voir plus bas), le processus est automatiquement mis en pause.

– l’icône suivante permet de choisir le mode de sélection (polyligne - par défaut - ou rectangulaire). En mode
’polyligne’ il est toujours possible de définir un contour rectangulaire en maintenant la touche CTRL et le bouton
gauche de la souris enfoncés.

– l’icône suivante permet d’appliquer la segmentation selon le contour courant et en gardant affichés les points
à l’intérieur du contour. Les autres points sont alors cachés et la segmentation est mise en pause. Le contour
doit être fermé.

– l’icône suivante permet d’appliquer la segmentation inverse (en gardant affichés les points à l’extérieur du
contour).

– l’icône suivante correspond à une réinitialisation complète de la sélection (tous les points redeviennent visibles).
– l’avant dernière icône permet de valider la segmentation globale et de quitter (les entités sélectionnées seront

chacune scindées en deux).
– enfin la dernière icône permet d’annuler la segmentation et de quitter (aucune opération ne sera effectuée).

1.5.2 Rotation/translation manuelle

L’outil transformation manuelle (ou transformation graphique interactive) est accessible via l’icône . Il permet
d’appliquer une rotation et/ou une translation manuelle aux entités sélectionnées.

A l’instar de l’outil de segmentation interactive (voir ci-dessus), l’outil s’active dans la vue 3D courante (et seules
les entités affichées dans cette vue sont pris en compte par CloudCompare). L’interface principale de CloudCompare
est aussi gelée. Trois icônes apparaissent en haut à droite de la vue 3D :

– la première permet de réinitialiser la transformation appliquées aux entités sélectionnées.
– la seconde permet de valider la transformation et de quitter.
– la dernière permet d’annuler la transformation et de quitter.

La transformation se fait interactivement avec la souris, en utilisant les mêmes conventions que pour la trans-
formation du point de vue (Cf. section 1.3.1.2) : le bouton gauche permet de tourner les entités (par rapport au
centre de gravité des boites englobantes de toutes les unités sélectionnées) et le bouton droit permet de translater
les entités dans le plan de l’écran. Dans ce mode, seules les entités sélectionnées bougeront, les autres restant fixes.

Note : si le processus est validé par l’utilisateur, la transformation effectivement appliquée est affichée dans la
console (sous forme textuelle). Cette information peut-être récupérée par copier-coller.

1.6 Barres de progression

Certains traitements ou opérations de CloudCompare nécessitent un temps de traitement relativement long, pou-
vant aller de quelques secondes à quelques minutes selon les capacités de l’ordinateur sur lequel l’application s’exé-
cute, ainsi que le paramétrage de la fonction et la complexité inhérente au traitement effectué. La barre de progression
est une fenêtre apparaissant durant les calculs non immédiats, donnant un aperçu de l’état d’avancement du traite-
ment.
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Parmi les commandes affichant une barre de progression, certaines laissent la possibilité d’arrêter le calcul en
cours d’exécution, via un bouton Cancel (l’arrêt du processus n’est pas forcément immédiat, le système ne prenant
en compte l’appui sur le bouton que lorsqu’il est suffisamment "disponible"). Lorsque ce bouton n’est pas visible, le
traitement ne peut être interrompu avant la fin.

1.7 Barres d’outils

Vous trouverez ci dessous la liste des boutons disponibles dans les diverses barres d’outils de CloudCompare.

Bouton Commande Description
Barre d’outils Main tools

Open cf. section 2.1.1

Save cf. section 2.1.2

Point picking cf. section 2.2.29

Point list picking cf. section 2.2.30

Clone cf. section 2.2.31

Fuse cf. section 2.2.32

Delete Supprimer les objets sélectionnés

Register cf. section 2.3.3

Align cf. section2.3.4

Subsample cf. section 2.2.35

Sample points cf. section 2.2.13

Cloud/Cloud distance cf. section 2.3.5

Cloud/Mesh distance cf. section 2.3.6

Statistical test cf. section 2.3.9

Label connected components cf. section 2.3.10

Segment cf. section 1.5.1

Translate/Rotate cf. section 1.5.2

Barre d’outils Scalar Field Tools

Show histogram Afficher l’histogramme du champ scalaire courant

Compute statistical parameters cf. section 2.3.8

Filter by value cf. section 2.2.23
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Bouton Commande Description

Gradient cf. section 2.2.21

Gaussian filter cf. section 2.2.22

Delete current scalar field Supprimer le champ scalaire actif du nuage sélectionné

Difference cf. section 2.2.24

Barre d’outils Plugins

peut contenir des éléments différents que ceux listés ici (en fonction des plugins disponibles)

Eye Dome Lighting (shader) cf. section 3.4

Screen Space Ambient Occlusion (shader) cf. section 3.2

Hidden Points Removal cf. section 3.4

Kinect Cloud Capture cf. section 3.7

PCL bridge cf. section 3.5

ShadeVis Ambient Occlusion cf. section 3.3

Poisson Surface Reconstruction cf. section 3.6

Ransac Shape Detection cf. section 3.8

Barre d’outils Viewing Tools

cette barre d’outils est présentée en détail en section 1.3.2

Les barres d’outils peuvent être affichées ou cachées via le sous-menu « Display > Toolbars ».

1.8 Raccourcis clavier

Voici les raccourcis clavier disponibles dans CloudCompare :

Touche(s) Commande Action Remarque
F1 Help affiche l’aide de CloudCompare
F2 Rename renomme l’entité sélectionnée l’entité doit être

sélectionnée
dans l’arbre de
navigation

F3 Toggle centered
perspective

active / désactive la projection prespective avec
centre de rotation au niveau des entités

cf. section 1.3.2

CTRL + F3 New 3D View ouvrir une nouvelle vue 3D
F4 Toggle viewer

based
perspective

active / désactive la projection prespective avec
centre de rotation confondu avec l’oeil de l’utilisateur

cf. section 1.3.2

CTRL + F4 Close 3D View fermer la vue 3D courante
F5 Refresh rafraîchir l’affichage
F6 Toogle sun light active / désactive la source lumineuse globale cf. section 1.3.2
F7 Toggle custom

light
active / désactive la source lumineuse secondaire cf. section 1.3.2
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Touche(s) Commande Action Remarque
F8 Toggle console affiche / cache la console
F11 Full screen active / désactive l’affichage en plein écran
CTRL + O Open pour ouvrir un fichier cf. section 2.1.1
CTRL + S Open pour sauver les entités sélectionnées cf. section 2.1.2
ALT + C Set Unique Color pour appliquer une couleur unique aux entités

sélectionnées
cf. section 2.2.1

CTRL + V Save Viewport créé un objet Point de vue correspondant au point
de vue actuel (vue 3D active)

cf. section 1.4.8

V Toggle entity
visibility

inverse l’état d’affichage des entités sélectionnées cf. section 1.4.1

N Toggle normals
visibility

inverse l’état d’affichage des normales des entités
sélectionnées

cf. section 1.4.1

C Toggle normals
visibility

inverse l’état d’affichage des couleurs des entités
sélectionnées

cf. section 1.4.1

S Toggle normals
visibility

inverse l’état d’affichage du champ scalaire
(courant) des entités sélectionnées

cf. section 1.4.1

Del/Suppr Delete supprime les entités sélectionnées
SHIFT + left
clic

Create 2D Label créé une étiquette 2D standard associée au point
désigné par le clic gauche (dans la vue 3D)

cf. section
1.2.4.2
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Chapitre 2

Fonctions

Dans ce chapitre sont détaillées les fonctions accessibles via le menu principal. Elles sont classées par ordre
d’apparition.

2.1 Menu ’File’

2.1.1 Open (file)

FIGURE 2.1 – Interface de sélection d’un fichier

Permet de charger un fichier via une interface standard (figure 2.1).

Remarques :
– Raccourci clavier : CTRL+O
– Si le chargement du fichier est réussi, les entités correspondantes seront automatiquement affichées dans la

vue 3D active.
– Le menu déroulant Look in / Regarder dans permet d’accéder à divers chemins usuels, ainsi qu’aux chemins

récemment utilisés
– Le menu déroulant Files of type / Fichiers du type permet de choisir un filtre pour l’affichage des fichiers

tout en donnant à CloudCompare une information sur le type de fichier à ouvrir (si le filtre est « All (*.*) »,
CloudCompare tentera de détecter automatiquement le bon type en fonction de son extension)

2.1.1.1 Formats supportés

Pour une liste des formats supportés, se référer à la section A.1 des annexes.
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2.1.1.2 Moyen alternatifs de chargement de fichiers

Il existe d’autres moyen de charger des fichiers dans CloudCompare :
– via la ligne de commande (voir annexes A.2)
– ou par drag & drop des fichiers (sélectionnés dans l’explorateur de Windows typiquement) directement dans

une vue 3D de CloudCompare.

Note : dans ces deux cas CloudCompare tentera de deviner le format de fichier via leur extension.

2.1.1.3 Cas des entités ayant des coordonnées très grandes

Si l’entité chargée a des coordonnées très grandes (au moins une des composante supérieure à 106), CloudCom-
pare le signifiera à l’utilisateur et lui proposera de recentrer automatiquement l’entité (voir figure 2.2). Par défaut le
recentrage se fait sur le premier point lu dans le fichier. Ce mécanisme permet d’éviter de perdre de l’information car
CloudCompare stocke les coordonnées des points sur 32 bits.

L’information de recentrage est conservée avec le nuage de points (voir les propriétés du nuage en section 1.4.2).
Elle sera conservée telle quelle si le fichier est sauvegardé dans le format binaire BIN. Et CloudCompare pourra
même rétablir les coordonnées originales si l’entité est sauvée dans les formats supportants les coordonnées sur 64
bits (LAS et E57) ou les formats ASCII (ASCII, OBJ, MA, VTK). Attention néanmoins, certaines opérations peuvent
faire perdre cette information à CloudCompare (fusion avec un nuage non recentré, etc.)

FIGURE 2.2 – Interface de recentrage d’un nuage au chargement

Remarque : si l’utilisateur charge plusieurs fichiers à la fois (via une sélection mutliple dans la boite de dialogue
de chargement par exemple) et que CloudCompare détecte un dépassement de coordonnées pour l’un des nuages,
l’utilisateur a alors le choix d’appliquer un recentrage à chaque nuage individuellement ou à tous les nuages qui
suivent (et qui nécessitent un recentrage).

2.1.2 Save (file)

Permet de sauvegarder dans un fichier l’entité sélectionnée (voire plusieurs entités à la fois si le format de fichier
choisi le permet). Le fichier est désigné via une interface standard (figure 2.1).

Remarques :
– Le menu déroulant Look in / Regarder dans permet d’accéder à divers chemins usuels, ainsi qu’aux chemins

récemment utilisés
– Dérouler le menu Files of type permet de filtrer les fichiers du répertoire courant affichés et de désigner le

format de sauvegarde (en fonction du type et du nombre d’entités sélectionnées, différents formats seront
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disponibles). Si le nom de fichier rentré par l’utilisateur n’a pas d’extension, l’extension par défaut pour ce
format sera automatiquement rajoutée.

2.2 Menu ’Edit’

2.2.1 Colors > Set Unique

FIGURE 2.3 – Interface de sélection d’une couleur unique

Permet de définir une couleur qui sera appliquée à tous les points/sommets des entités 3D sélectionnées. Le
choix est manuel, et se fait via une interface classique proposant divers modes de sélection (figure 2.3) :

– soit en choisissant une couleur basique (en haut à gauche), ou une couleur précédemment sauvegardée (cus-
tom - en bas à gauche)

– soit en cliquant sur la zone colorée (en haut à droite) et en faisant varier l’intensité avec l’ascenseur en dégradé
(à droite)

– soit en rentrant manuellement les paramètres dans les trois champs HSV ou RGB (en bas à droite)
Raccourci clavier : ALT+C

2.2.2 Colors > Colorize

Même interface que la fonction "Set Unique" (2.2.1 - voir ci-dessus).

Cette fonction permet de modifier les couleurs actuelles des points par multiplication des composantes de la cou-
leur actuelle par celles de la couleur sélectionnée.

Soit (r, g, b) les composantes rouge, vert et bleu d’un point, et (rm, gm, bm) la couleur à multiplier :

(r′, g′, b′) = (r ∗ rm
255

, g ∗ gm
255

, b ∗ bm
255

)

Remarque : si l’entité n’a pas de couleur, alors la fonction se comportera comme "Set Unique".

2.2.3 Colors > Height Ramp

L’utilisateur à le choix entre appliquer une rampe par défaut (figure 2.5) ou alors une rampe dont il définit les deux
couleurs extrêmes (figure 2.4). Il faut pour cela désactiver la case à cocher Use default ramp. Les deux couleurs ex-
trêmes du dégradé peuvent alors être définies en cliquant sur les boutons colorés First color et Second color (qui font
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FIGURE 2.4 – Interface de sélection d’une rampe de couleur

FIGURE 2.5 – Exemple d’un dégradé selon Z (couleurs par défaut)

apparaître des interfaces de sélection de couleur équivalentes à celle de la méthode Set Unique - Cf. section 2.2.1).

Via la liste déroulante direction, l’utilisateur doit aussi définir selon quelle direction le dégradé sera appliqué (parmi
les 3 directions principales : X, Y ou Z).

2.2.4 Normals > Compute

FIGURE 2.6 – Interface pour le calcul des normales
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Cette fonction ne permet pas de calculer des normales signées. Pour ceci utilisez la méthode Estimate Normals
and Curvature de la librairie PCL via le plugin qPCL (voir 3.5).

Cette fonction permet de calculer les normales (non signées) d’un nuage de points.

L’utilisateur peut spécifier le modèle d’approximation locale de la surface parmi :
– Plane : plan aux moindres carrés (le plus rapide)
– Height function : quadrique (le plus précis)
– Triangulation : triangulation 2D 1

2 de type Delaunay (intérmédiaire)

L’utilisateur doit aussi spécifier la taille du voisinage pour la modélisation locale (local radius : plus celui-ci est
grand et plus le résultat sera lisse ... et le calcul lent).

Enfin, si une direction privilégiée pour les normales est disponible, l’utilisateur peut la spécifier pour aider Cloud-
Compare à signer les normales. Il faut activer la case à cocher Prefered orientation et spécifier une des 6 orientations
par défaut (-X,+X,-Y,+Y,-Z,+Z). Autrement, l’utilisateur peut tenter sa chance auprès de la méthode Resolve direction
(Cf. section 2.2.7).

2.2.5 Normals > Convert to HSV

Cette fonction permet de convertir les normales d’un nuage en couleur (voir figure 2.7) via deux transformations
successives :

– une première transformation des normales en indication de pendage (Strike and dip en anglais - Cf. wikipedia)
– puis une seconde transformation des informations de pendage vers l’espace HSV (Hue Saturation Value ou

Teinte, Saturation, Valeur en français) : strike→ H ; dip→ S ; V = constante.

FIGURE 2.7 – Exemple de conversion de normales vers l’espace de couleur HSV

La méthode créé le champ Couleur si besoin (et sinon écrase la champ existant). Elle cache aussi automatique-
ment les normales.

2.2.6 Normals > Invert

Inverse les normales des entités sélectionnées (nuages ou maillages).

Note : cela permet notamment de corriger le problème du sens des triangles (direct ou indirect) de certains
maillages.

2.2.7 Normals > Resolve direction

Cette fonction est une ébauche. Pour obtenir des normales signées, utilisez la méthode Estimate Normals and
Curvature de la librairie PCL via le plugin qPCL (voir 3.5).

http://en.wikipedia.org/wiki/Strike_and_dip
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Cette fonction tente de résoudre le sens des normales d’un nuage de proche en proche, par propagation d’un ou
plusieurs fronts sur le nuage (algorithme de type Fast Marching).

La propagation se fait sur une grille 3D (ici l’octree) et il faut donc choisir un niveau d’octree auquel appliquer
l’algorithme. Le choix du bon paramètre n’est malheureusement pas évident, car un niveau faible va entraîner des
cellules de taille importante, d’où une propagation aisée et rapide mais une mauvaise prise en compte des circon-
volutions locales, alors qu’un niveau élevé va entraîner l’inverse. De plus, plus la propagation est difficile - i.e. par
morceaux - plus le risque de voir des zones proches ayant des sens opposés est forte. Il faut donc essayer l’algo-
rithme à différents niveaux d’octree, en commençant typiquement à 5 ou 6, puis augmenter le niveau jusqu’à trouver
une valeur satisfaisante.

Note : la résolution du sens des normales est au sens global près, il peut donc être nécessaire d’utiliser la fonction
Invert (Cf. section 2.2.6) pour obtenir le résultat final recherché.

2.2.8 Octree > Compute

Cette fonction calcule une structure octree (subdivision récursive de l’espace) pour le ou les nuages de points
sélectionnés. Une fois l’octree calculé avec succès, il est affiché automatiquement (Cf. section 1.4.5).
Remarque : l’utilisateur n’a jamais besoin de déclencher le calcul de l’octree lui même, CloudCompare le fera auto-
matiquement si besoin. Cette fonction permet juste d’afficher l’octree si celui-ci n’a pas déjà été calculé.

2.2.9 Octree > Resample

FIGURE 2.8 – Interface pour ré-échantillonnage par Octree

Fonction de ré-échantillonnage (grossier) d’un nuage. L’utilisateur spécifie un nombre approximatif de points (via
l’interface 2.8), et CloudCompare détermine alors le niveau d’octree ayant un nombre de cellules le plus proche de
cette valeur. Le nuage ré-échantillonné est alors formé en remplaçant chaque cellule par un point représentatif (ac-
tuellement, le centre de gravité des points présents à l’intérieur de la cellule).

Remarque : cette méthode est différente de la méthode Subsample (Cf. section 2.2.35) car elle crée de nouveaux
points 3D à des positions différentes de celles des points d’origine, contrairement à la méthode Subsample qui ne
fait que sélectionner des points existants dans le nuage d’origine.

2.2.10 Mesh > Delaunay 2D

Cette fonction permet de calculer un maillage 2D 1
2 de type Delaunay à partir d’un nuage de points.

Puisque la méthode produit un maillage 2D 1
2 à partir d’un nuage de points 3D, CloudCompare doit projeter

préalablement celui-ci sur un plan avant de calculer sa triangulation associée. Ainsi cette méthode est-elle déclinée
en deux versions :

– axis aligned plane : CloudCompare estime que les altitudes sont portées par l’axe principal Z et les points sont
donc projetés sur le plan (XY)

– best LS plane : approche plus générique, où les points sont projetés sur le plan interpolant le mieux le nuage
au sens des moindres carrés (cette méthode est particulièrement adaptée aux nuages assez plats dont les
altitudes ne sont pas forcément portées par Z).
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2.2.11 Mesh > Best fitting quadric

Cette méthode est une méthode recherche (c.à.d. utilisée pour des tests) non détaillée.

2.2.12 Mesh > Sample Points

Cette fonction échantillonne de manière aléatoire des points sur une surface décrite par un maillage triangulaire
(voir figure 2.9).

FIGURE 2.9 – Illustration du principe de l’échantillonnage de points sur un maillage

Cette fonction génère un nouveau nuage de points. L’utilisateur à le choix via l’interface 2.10 de spécifier :
– soit le nombre total de points désiré (approximatif).
– soit la densité par unité de surface. Attention, la surface est exprimée dans l’unité implicite (au carré) des som-

mets du maillage. Pour connaître la surface totale du maillage , vous pouvez appeler préalablement la fonction
« Mesh > Measure surface » (section 2.2.14).

FIGURE 2.10 – Interface pour l’échantillonnage de points sur un maillage

2.2.13 Mesh > Smooth (Laplacian)

Cette fonction lisse un maillage par approche de type Laplacien (voir figure 2.11). Attention, ce type d’approche
ne conserve pas la volume du maillage. De plus, les sommets du maillage sont déplacés.

Avant d’appliquer cette fonction, CloudCompare demande à l’utilisateur de définir deux paramètres :
– le nombre d’itérations : plus les itérations sont nombreuses, plus le lissage est fort... et plus la méthode est

longue.
– la force du lissage à chaque itération : plus celle-ci est élevée, et plus le lissage est fort (ce qui peut permettre

de diminuer le nombre d’itérations - voir ci-dessus) mais plus les risques de problèmes topologiques sont éle-
vés.



36 CHAPITRE 2. FONCTIONS

FIGURE 2.11 – Maillage avant (à gauche) et après (à droite) lissage de type Laplacien

2.2.14 Mesh > Measure Surface

Calcule la surface du maillage.

Cette surface est exprimée dans l’unité implicite (au carré) des sommets du maillage.

2.2.15 Mesh > Scalar Field > Smooth

FIGURE 2.12 – Exemple de résultats obtenus avec les options smooth et enhance d’un champ scalaire porté par les
sommets d’un maillage

Cette méthode lisse spatialement les valeurs d’un champ scalaire porté par les sommets d’un maillage, en utili-
sant la topologie du maillage. La valeur scalaire au niveau d’un sommet est remplacée par une moyenne (pondérée
par la distance) des valeurs scalaires portées par les sommets voisins.

Remarque : cette fonction est beaucoup plus rapide que la fonction Gaussian filter (section 2.2.22) appliquée à
un nuage de points non structuré. Elle ne permet par contre pas de régler la taille du noyau de lissage.

2.2.16 Mesh > Scalar Field > Enhance

Cette méthode réhausse le contraste d’un champ scalaire porté par les sommets d’un maillage, en utilisant la to-
pologie du maillage. La valeur scalaire au niveau d’un sommet est modifiée pour augmenter le contraste en prenant
en compte les valeurs scalaires portées par les sommets voisins (et leur distance respective).

Cette fonction est l’inverse de Mesh > Scalar Field > Smooth (voir section 2.2.15).
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2.2.17 Sensor > Ground-Based Lidar > Show depth buffer

FIGURE 2.13 – Carte de profondeur associée à une entité scanner (GBL sensor )

Affiche la carte de profondeur associée à un capteur (GBL sensor - voir figure ??). Elle correspond aux points 3D
affichés en fausses couleurs (en fonction de la distance par rapport au capteur) et projetés dans le repaire polaire du
scanner (lié à la rotation des mirroirs).

2.2.18 Sensor > Ground-Based Lidar > Export depth buffer

Cette fonction permet d’exporter la carte de profondeur associée à un capteur sous la forme d’un fichier texte.

L’utilisateur est invité à spécifier un nom de fichier dans lequel seront sauvegardées toutes les informations rela-
tives à la carte de profondeur (voir section A.1.4.2).

2.2.19 Sensor > Create

Cette fonction permet ce créer une entité capteur (de type scanner laser terrestre par défaut) associé à un nuage.
Le nuage doit être sélectionné avant d’appeler cette fonction.

Cela permet de modéliser a posteriori le scanner qui a permis l’acquisition du nuage de points sélectionné. L’objet
scanner peut-être utilisé notamment pour filter les points non comparables lors du calcul de distance entre deux
nuages de points (Cf. section 2.3.5).

Lors de la création d’un capteur, de nombreux paramètres sont réglables (via les différents onglets de l’inter-
face 2.14) :

– rotation order : ordre des rotations du scanner (moteur, miroir). Nous utilisons ici les angles θ et φ suivant
les conventions habituelles des coordonnées sphériques : θ représente l’angle (le débattement) horizontal du
capteur, φ représente l’angle vertical du capteur. Il existe deux choix actuellement : θ puis φ (type GS de
Trimble) ou φ puis θ (type Soisic de Trimble).

– Position (center)/(X,Y,Z) : position X,Y,Z du centre optique du scanner (exprimée dans le référentiel du nuage
de point)

– Position (center)/Sensor base : écart entre l’émetteur laser et le récepteur (utile pour un capteur à triangulation
comme le Soisic typiquement).
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FIGURE 2.14 – Interface de paramètrage pour la création d’un capteur

– Orientation : repère du capteur exprimé par rapport au repère du nuage (trois vecteurs). Par défaut, la matrice
formée par ces trois vecteurs est laisée à l’identité, ce qui revient à avoir une orientation droite selon les 3 axes
du repère courant.

– Angular steps/dPhi : pas angulaires (en degrés) du capteur selon φ.
– Angular steps/dTheta : pas angulaires (en degrés) du capteur selon θ.
– Other/Uncertainty : l’incertitude sur la mesure laser, en pourcentage (déduite automatiquement lors de la pro-

jection).
– Other/Max. range : la portée maximale (déduite automatiquement lors de la projection).

Une fois les paramètres renseignés, CloudCompare créé un objet GBL sensor associé au nuage. Celui-ci contient
entre autre une carte de profondeur du nuage (voir section 2.2.17). Enfin l’objet capteur est affichable en situation
sous la forme d’un petit capteur 3D schématique (voir figure 2.13 et section 1.4.10).

2.2.20 Sensor > Modify

Permet de modifier les paramètres d’une entité capteur (GBL sensor ).

L’utilisateur peut mettre à jour les paramèters de l’entité capteur via la même boîte de dialogue que dans le cas
de la création d’une entité capteur (voir 2.2.19).

2.2.21 Scalar Fields > Gradient

FIGURE 2.15 – Interface de paramètre pour le calcul des normales



2.2. MENU ’EDIT’ 39

Cette fonction permet de calculer les normes du gradient du champ scalaire actif.

CloudCompare demande à l’utilisateur de préciser si le champ scalaire correspond à une distance euclidienne
(telles que les distances calculées entre deux nuages ou entre un nuage et un maillage - voir 2.3.5 ou 2.3.6). Si oui,
l’algorithme filtrera les valeurs aberrantes (qui sont alors facilement détectables car dans ce cas la valeur absolue du
gradient ne peut être supérieure à 1).

Remarques :
– L’algorithme crée un nouveau type de champ scalaire (Gradient norms).
– Comme pour du traitement d’image 2D classique, le gradient permet notamment de mettre en valeur les zones

de fortes variations du champ scalaire (on met ainsi en évidence les bords des zones de changement par
exemple - voir figure 2.15).

– Comme pour du traitement d’image 2D classique, il est souvent nécessaire d’appliquer un filtre gaussien aux
données avant et/ou après un calcul du gradient (Cf. section 2.2.22).

– Le fait que la valeur de la norme du gradient ne soit jamais supérieure à 1 est vrai en réalité pour tout champ
scalaire dont les valeurs varient proportionnellement à la distance entre les points (c’est donc le cas d’un champ
de distances).

2.2.22 Scalar Fields > Gaussian Filter

Application d’un filtre gaussien au champ scalaire actif.

L’utilisateur doit définir le noyau sigma du filtre gaussien. Pour régler ce paramètre simplement, on peut se servir
de l’octree, en prenant typiquement comme valeur la taille d’une cellule au niveau 8 pour un filtrage doux, 7 pour un
filtrage relativement fort, etc. (la taille d’une cellule est affichée au niveau de la console lorsqu’on affiche un rendu du
nuage via l’octree - Cf. section 1.4.5).

Remarques :
– A partir de sigma, on peut déduire très simplement le rayon de la sphère en 3D délimitant le voisinage qui sera

considéré autour de chaque point. On calcule en effet pour chaque point la moyenne des valeurs scalaires
de ses voisins, pondérée par la distance selon une loi gaussienne. Etant donné que 3σ correspond à un
écrasement du poids de 99,9%, CloudCompare ne considére pas les points plus éloignés.

– Plus le noyau est grand, plus le calcul est lent.
– Cette fonction est très utile pour lisser le résultat d’un calcul du gradient (section 2.2.21) mais aussi d’un calcul

de Portion de Ciel Visible (section ??) sur un nuage de points par exemple.

2.2.23 Scalar Fields > Filter by Value

FIGURE 2.16 – Interface de paramètrage pour le filtrage des points selon la valeur du champ scalaire actif

Cette fonction permet de segmenter un nuage en définissant un intervalle de valeurs scalaires (figure 2.16). Un
nouveau nuage sera créé avec tous les points dont les valeurs scalaires (tirées du champ scalaire actif) sont inclues
dans cet intervalle. Lors de l’appel de la fonction, les valeurs par défaut de la boite de dialogue correspondent aux
valeurs min displayed et max displayed des paramètres d’affichage du champ scalaire actif (voir section 1.4.4.1).
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FIGURE 2.17 – Interface de la méthode « Scalar Fields > Arithmetic »

2.2.24 Scalar Fields > Arithmetic

Cet outil permet d’effectuer des opérations élémentaires (addition, soustraction, multiplication et division) entre
des champs scalaires d’un même nuage.

Pour appeler cette méthode, un seul nuage doit être sélectionné. L’utilisateur doit alors choisir un champ scalaireA
et un champ scalaire B ainsi qu’un type opération (voir figure 2.17). Un champ scalaire champC = champAopchampB
sera alors créé.

Remarque : le champ scalaire créé (C) est par défaut signé, même si les champs A et B sont non signés. Si cela
est nécessaire, l’utilisateur peut manuellement spécifier que ce champ scalaire est non signé (voir section 1.4.4.1 -
case à cocher Postive).

2.2.25 Scalar Fields > Multiply

Cette fonction n’est pas encore intégrée à la version 2.4 de CloudCompare.

2.2.26 Scalar Fields > Convert to RGB

Cette méthode sauve le champ scalaire actif tel qu’affiché sous formes de couleurs (RGB).

Si l’entité possède déjà des couleurs, CloudCompare donne deux options à l’utilisateur : il est possible d’écraser
les couleurs existantes ou de les multiplier (voir l’outil « Colorize » en section 2.2.2).

2.2.27 Scalar Field > Rename

Cet outil permet de renommer le champ scalaire actif.

2.2.28 Bounding-box > Fit principal components

Cette méthode est une méthode recherche (c.à.d. utilisée pour des tests).
Cet outil permet de calculer une boite englobante optimale par analyse en composantes principales.

2.2.29 Point picking

L’outil de picking de points permet de sélectionner un ou plusieurs points 3D (parmi les nuages affichés) pour
afficher des étiquettes avec des informations diverses (notamment des mesures entre points : distance, angle, etc.).

L’outil de picking de points s’active dans la vue 3D courante. Une barre d’icônes apparaît alors dans son coin haut-
droit et l’interface principale de CloudCompare est gelée (la plupart des icônes et menus ne sont plus accessibles,
mis à part les options d’affichage). Celle-ci est rétablie quand l’utilisateur quitte l’outil (dernière icône à droite en
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FIGURE 2.18 – Interface de picking de points 3D

forme de croix rouge).
En pratique, cet outil permet de créer des étiquettes (voir section 1.2.4.2 associée à un ou plusieurs points ou à une
zone de l’écran. Les 3 premières icônes de la barre d’outil permettent de créer une étiquette liée à un, deux ou trois
points respectivement :

– 1 point : l’utilisateur sélectionne un point et une étiquette 2D standard apparaît avec les informations relatives
à ce point (coordonnées, indice dans le nuage, couleur, valeur scalaire active, etc.).

– 2 points : l’utilisateur sélectionne deux points successivement (lors de la sélection du premier point, l’étiquette
précédente apparaît) et des informations sur le segment ainsi défini sont alors affichées (dont particulièrement
la distance entre les deux points).

– 3 points : l’utilisateur sélectionne trois points successivement (lors de la sélection du premier point et du second
point, les deux étiquettes précédentes apparaîssent) et des informations sur le triplet de points ainsi défini sont
alors affichées (dont particulièrement la normale et la surface du triangle correspondant ainsi que l’angle au
niveau du premier point).

– La quatrième icône permet de créer une étiquette de type zone 2D.
– La cinquième icône (disquette) permet de sauver l’étiquette courante sous la forme d’une vraie entité (autre-

ment la création d’une nouvelle étiquette ou quitter l’outil entraine la supression de l’étiquette courante).
– L’icône suivante permet de réinitialiser l’outil (suppression de l’étiquette courante).
– Et enfin la dernière icône permet de quitter l’outil (suppression de l’étiquette courante).

2.2.30 Point list picking

L’outil de picking d’une liste de points permet de sélectionner interactivement une liste de points 3D d’un nuage
(et de la sauver dans un fichier ou un nouveau nuage).

L’outil de picking d’une liste de points s’active dans la vue 3D courante et pour un nuage de point qui doit être
préalablement sélectionné. Une interface apparaît alors dans son coin haut-droit et l’interface principale de Cloud-
Compare est gelée (la plupart des icônes et menus ne sont plus accessibles, mis à part les options d’affichage).
Celle-ci est rétablie quand l’utilisateur quitte l’outil (dernière icône à droite en forme de croix rouge).
Cet outil permet de sélectionner une liste de points (par clicks successifs sur les points dans la vue 3D). Chaque point
est ajouté à un tableau qui affiche les points dans leur ordre de sélection avec 5 colonnes : l’indice du point dans la
liste (cet indice apparaît aussi à côté du point dans la vue 3D) ; l’indice du point dans le nuage ; et les coordonnées
du point dans les 3 dernières colonnes (X, Y et Z).
Une fois la liste formée, il est possible de l’exporter avec l’icône “disquette” (celle-ci fait apparaître une liste dérou-
lante) :
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FIGURE 2.19 – Interface de picking d’une liste de points 3D

– (x,y,z) : exporte la liste sous la forme d’un fichier de points (ASCII - un point par ligne) avec uniquement les
coordonnées des points (x,y,z)

– (local index,x,y,z) : exporte la liste sous la forme d’un fichier de points (ASCII - un point par ligne) avec les
coordonnées des points précédées de l’indice du point dans la liste (i,x,y,z)

– (new cloud) : exporte la liste sous la forme d’un nouveau nuage de points

Les autres icônes permettent de :
– supprimer le dernier point dans la liste (première icône - “flêche” qui se mord la queue)
– valider la sélection et fermer l’outil (icône avec symbole vert). Dans ce cas les points de la liste sont conservés

dans un sous groupe Picked points list sous forme d’étiquettes (cachées en 2D par défaut). Si une liste de
points est associée à un nuage, ouvrir à nouveau l’outil avec ce nuage rétablira automatiquement la liste dans
le tableau (qui pourra donc être modifiée à nouveau).

– annuler la sélection et fermer l’outil (icône avec une croix rouge). Dans ce cas toutes les modifications appor-
tées sont annulées (si une liste prééxistait elle sera rétablie).

Il est aussi possible de changer la taille des marqueurs de points (via le champ marker size en bas à gauche) et
aussi de changer l’indice de départ de la liste (champ local start index).

2.2.31 Clone

Créé une nouvelle entité identique en tout point à celle sélectionnée (et indépendante de cette dernière). Toute
modification de l’entité clonée n’aura aucun impact sur l’entitée d’origine (et inversement).

Remarques :
– actuellement seuls les nuages et les maillages peuvent être clonés.
– attention à la consommation mémoire !

2.2.32 Fuse

Fusionne deux (ou plus) entités sélectionnées. Attention : les listes fusionnées sont supprimées à l’issue de cette
opération.

Remarques :
– actuellement seuls les nuages ou les maillages peuvent être fusionés.
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– toutes les caractéristiques des entités sont conservées. Les entités ne possédant pas initialement telle ou telle
caractéristique (couleur, normale, champs scalaires, etc.) la gagneront, avec des éléments par défaut (couleur
blanche, normale nulle, valeur scalaire de type NaN, etc.).

2.2.33 Apply transformation

FIGURE 2.20 – Interface de définition d’une transformation 3D (avec aide affichée)

Cet outil permet à l’utilisateur de spécifier une transformation 3D (matrice 4× 4 composée d’une matrice de rota-
tion dans la partie supérieure à gauche et d’un vecteur translation dans la partie supérieure de la dernière colonne).
Cette transformation (ou son inverse si la case à cocher Apply inverse transformation est activée) peut alors être
appliquée aux entitées sélectionnées.

Remarques :
– une aide peut-être affichée en appuyant sur le bouton en haut à gauche (voir figure 2.20).
– après une transformation manuelle (voir section 1.5.2) ou un recalage de type ICP (voir section 2.3.3) Cloud-

Compare affiche dans la console la transformation appliquée aux entités. Cette transformation peut-être sélec-
tionnée dans la console et récupérée - en copiant le texte avec CTRL+C - puis collée - CRTL+V - dans l’outil
(attention, il faut faire attention aux premiers caractères du texte collé qui correspondent à l’heure du message
et qui doivent donc être supprimmés avant d’appliquer la transformation !). Ceci permet notamment soit d’an-
nuler une transformation (en appliquant la transformation inverse) ou alors d’appliquer la même transformation
à une autre entitée après un recalage (on peut en effet vouloir segmenter/nettoyer un nuage avant d’appliquer
l’algorithme ICP - pour obtenir un meilleur recalage - puis appliquer la transformation obtenue au nuage d’ori-
gine).

2.2.34 Multiply

Multiplie les coordonnées des points des entités sélectionnées par des constantes.

L’utilisateur saisit les 3 coefficients multiplicateurs suivant chaque axe (fX , fY , fZ) via une boîte de dialogue
(voir 2.21).
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FIGURE 2.21 – Boîte de dialogue pour la multiplication des coordonnées

FIGURE 2.22 – Interface de paramètrage pour le sous-échantillonnage de nuages

2.2.35 Subsample

Fonction de sous-échantillonnage des points d’un nuage.

Différentes méthodes sont disponibles. Le choix (ainsi que le paramétrage) se fait via une boîte de dialogue (voir
figure 2.22) :

– Random : sous-échantillonnage aléatoire (les points sont tirés au hasard). L’utilisateur choisit le nombre de
points restants.

– Space : sous-échantillonnage spatial. L’utilisateur choisit la densité du nuage résultant via l’espace moyen
inter-points maximal (valeur approximative).

– Octree : sous-échantillonnage rapide via l’octree. On garde un point par cellule de l’octree à un niveau donné
de subdivision. L’utilisateur choisit le niveau de subdivision (plus le niveau est faible et moins le nombre de
points est important).

Remarques :
– Le sous-échantillonnage diffère du ré-échantillonnage (cf. section 2.2.9) dans le sens où il ne crée pas de

nouveaux points mais se contente de sélectionner un sous-ensemble de points à partir du nuage source.
– La méthode de sous-échantillonnage rapide via l’octree choisit le point le plus proche du centre dans chaque

cellule. Ainsi l’écart entre les points est à peu près constant (si le nuage initial est suffisamment dense).

2.2.36 Synchronize

Fonction permettant d’aligner deux entités : elle applique simplement une translation à la deuxième entitée pour
faire coïncider son centre de gravité avec celui de la première entité.

Remarque : pour appeler cette fonction, il faut sélectionner deux entités et uniquement deux.

2.3 Menu ’Tools’

2.3.1 Tools > Projection > Unroll

Cette fonction permet de développer sur un plan un nuage de point considéré comme étant porté par une forme
de révolution (cylindre ou un cone). Voir figure 2.24.
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FIGURE 2.23 – Interface de paramètrage pour l’outil de développement d’un nuage

Il faut pour cela renseigner différents paramètres définissant la forme de révolution :
– le type (cylindre ou cone)
– la dimension selon laquelle est positionnée l’axe de développement (X, Y ou Z pour l’instant)
– un point par lequel passe cet axe (dans le cas où la checkbox auto axis est sélectionnée, ce point est automa-

tiquement remplacé par le centre de gravité du nuage)
– le rayon du cylindre ou la base du cone
– et l’angle d’ouverture du cone le cas échéant

Attention, pour optimiser la mémoire, cette fonction applique la transformée directement sur l’entité sélectionnée !
Il peut être nécessaire d’utiliser avant l’outil de clonage - voir section 2.2.31.

FIGURE 2.24 – Exemple de résultat : nuage de points cylindrique (à gauche), et sa développée (à droite)

2.3.2 Tools > Projection > Height Grid Generation

Cette fonction permet de projeter un nuage de point sur une grille régulière suivant l’axe Z.

Une interface (figure 2.25) permet de régler différents paramètres :
– grid step : le pas de la grille exprimé dans l’unité des coordonnées du nuage de points
– type of projection : ce paramètre peut prendre l’une des 2 valeurs suivantes :

– maximum height : soit Eij le sous-ensemble de points du nuage qui est projeté dans la case (i,j) de la grille.
Pour chaque case (i,j) de la grille, on retient comme altitude Z celle du point le plus haut dans Eij .



46 CHAPITRE 2. FONCTIONS

FIGURE 2.25 – Interface de paramètrage pour l’outil de projection d’un nuage sur une grille

– average height : pour chaque case (i,j) de la grille, on retient comme altitude Z l’altitude moyenne des points
de Eij .

– fill empty cells with : certaines cases de la grille régulière restent vides après projection (aucun point du nuage
ne s’y projette). Ce paramètre indique avec quelle valeur l’on doit renseigner ces cases et peut prendre l’une
des 3 valeurs suivantes :
– minimum height : les cases vides sont renseignées avec l’altitude Z minimale parmi tous les points du nuage.
– average height : les cases vides sont renseignées avec l’altitude Z moyenne de tous les points du nuage.
– maximum height : les cases vides sont renseignées avec l’altitude Z maximale parmi tous les points du

nuage.

Cette fonction génère deux fichiers (dans le répertoire du binaire de CloudCompare par défaut) :
– height_grid_image.tiff : l’image raster 2D codée sur 256 niveaux de gris correspondant aux altitudes Z des

points projetés dans les cases de la grille ;
– height_grid_text_file.txt : les données de la grille sous un format ASCII (fichier exploitable simplement par un

programme).

Voir figure 2.26 pour exemple de résultat produit par cette fonction.

FIGURE 2.26 – Exemple de résultat : vue 3D à gauche, image 2D des hauteurs à droite

2.3.3 Tools > Registration > Register

Cette fonction permet de recaler deux nuages de points (algorithme "Iterative Closest Point" de Besl et McKay,
IEEE Trans. PAMI 1992).
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FIGURE 2.27 – Interface de paramètrage pour l’outil de recalage de deux entités

Attention : pour que ce recalage fonctionne, il est nécessaire que les deux nuages soit à peu près alignés.

Cette fonction ne permet en aucun cas d’aligner des nuages positionnés et orientés de manière quelconque. Son
rôle est essentiellement d’affiner le recalage des nuages de points dont on estime qu’ils sont grossièrement alignés.
La fonction Align décrite en section 2.3.4 permet de faire en sorte que les nuages soient approximativement alignés
et la fonction Register peut être utilisée sur les deux nuages résultant de cette fonction Align.

La zone supérieure (Model and Data) de la fenêtre de paramètrage permet à l’utilisateur d’attribuer interactive-
ment le rôle de chaque entité. Le Model est le nuage de référence (qui ne bouge pas) et Data désigne le nuage à
recaler (il pourra bouger si nécessaire). Pour aider l’utilisateur, CloudCompare force la coloration des entités et leur
affichage (model en rouge et data en jaune) selon le même principe que l’interface de choix des rôles avant un calcul
de distances (voir paragraphe ci-dessous). Un bouton permet d’intervertir ces roles si besoin (swap).

La partie inférieure (Registration parameters) correspond aux paramètres de l’algorithme de recalage en tant que
tel. Voici leur détail :

– Stop criterion : l’utilisateur choisit soit un nombre d’itérations fixe (ceci permet d’éviter un temps de calcul trop
long, mais ne garantit pas la qualité du recalage) ou au contraire une diminution de l’erreur minimale entre deux
itérations pour justifier d’autres itérations : autrement, l’algorithme s’arrête, estimant que le gain en précision
est insuffisant (ce qui garantit une meilleure qualité mais peut prendre potentiellement beaucoup de temps).

– Enable furthest point removal : heuristique adaptée au recalage d’entités légèrement différentes (puisque
CloudCompare est justement fait pour comparer des nuages potentiellement différents, alors que l’algorithme
est pensé pour recaler des nuages représentant les mêmes objets !). Cet heuristique consiste à écarter les
points trop éloignés à chaque itération du recalage (et ce de plus en plus), pour éviter que les différences entre
les nuages ne fassent trop glisser la position finale du nuage recalé).
Donc cette option ne doit pas être cochée si les deux nuages représentent les mêmes objets.

2.3.4 Tools > Registration > Align

Cette fonction permet de recaler grossièrement deux nuages de points (algorithme "4 points Congruent Sets For
Robust Registration" de Aiger, Mitra et Cohen-Or, Siggraph 2008).

Une première zone de saisie (en haut à gauche) permet d’indiquer les 2 nuages à recaler et leurs rôles respectifs
(Model and Data : le Model est le nuage de référence (qui ne bouge pas) sur lequel viendra s’aligner (si possible) le
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FIGURE 2.28 – Interface de paramétrage pour l’outil de recalage grossier de deux entités

nuage Data. Comme le recalage calculé est un recalage rigide, seules des translations et des rotations peuvent être
appliquées à l’ensemble du nuage Data. Plusieurs autres paramètres doivent être renseignés par l’utilisateur pour
une utilisation optimale de cette méthode.

Sampling : cette zone concerne l’étape préalable de sous-échantillonnage des nuages de points. Cela permet
d’améliorer sensiblement l’efficacité de l’algorithme. En effet, quelques dizaines de milliers de points suffisent gé-
néralement à obtenir un bon recalage, alors que la complexité de l’algorithme augmente rapidement en fonction du
nombre de points. L’utilisateur devrait toujours chercher à minimiser le nombre de points pris en compte, quitte à
relancer l’algorithme avec plus de points si besoin. Voici les paramètres du sous-échantillonnage :

– Method : méthode de sous-échantillonnage (voir section 2.2.35). Sélectionnez None pour ne pas sous-échantillonner
– Model : un slider et/ou un champ avec variateur permet de choisir le nombre de points conservé pour le nuage

de référence
– Data : idem, un slider et/ou un champ avec variateur permet de choisir le nombre de points conservé pour le

nuage recalé

Registration parameters : cette zone correspond aux paramètres de l’algorithme de recalage en tant que tel. Nous
expliquons en détail ces paramètres :

– Number of trials : l’algorithme procède par essais successifs et ne retient que celui ayant fourni le meilleur
résultat. Ce champ permet de choisir le nombre d’essais à effectuer. Plus la valeur saisie est grande, plus le
calcul sera long, mais plus la probabilité d’obtenir de bons résultats sera élevée. Il peut donc être nécessaire
d’adapter ce paramètre en fonction du nombre de points composant les nuages pour obtenir un bon alignement
dans un temps raisonnable. Pour donner un ordre d’idée, une cinquantaine d’essais pour recaler deux nuages
de 5000 points chacun permet d’obtenir un résultat convenable en quelques minutes (de l’ordre de 2 à 5
minutes, tout dépend de l’ordinateur sur lequel le programme s’exécute).

– Overlap : ce paramètre, compris entre 0.0 et 1.0, correspond à une estimation du taux de recouvrement entre
les deux nuages lorsqu’ils sont correctement alignés. Un taux de recouvrement de 1 signifie que les deux
nuages se recouvrent quasiment entièrement, 0 signifiant que les nuages sont disjoints (dans ce cas, le reca-
lage n’a pas beaucoup de sens). Une estimation très approximative du recouvrement est en général suffisante,
il ne s’agit en aucun cas de renseigner avec précision la valeur effective.

– Delta : ce paramètre correspond à une estimation a priori de la distance moyenne qui existera entre les points
des deux nuages après qu’ils aient été recalés. Il sert de critère d’arrêt et agit comme une tolérance à l’erreur :
plus il est proche de 0, plus on contraint les nuages à être proches, mais plus la probabilité de trouver une bonne
solution est faible. En principe, si Delta vaut zéro, le programme ne pourra pas trouver d’alignement entre les
deux nuages. En règle générale, pour obtenir de bons résultats, Delta doit correspondre à la résolution (inverse
de la densité) du nuage de référence. L’interface propose un bouton Estimate qui permet d’estimer de manière
automatique ce paramètre en se basant sur un calcul de la densité moyenne du nuage de référence.

– Limit max. number of candidates : lorsque ce champ est activé (pour celà, cocher la case qui y est associé),
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il est possible de fixer le nombre maximal de candidats que le programme est autorisé à traiter pour chaque
essai. En effet, lors d’un essai, le processus recherche dans le nuage servant de données des ensembles
de points pouvant mener à un bon recalage. Ces ensembles sont calculés en fonction des paramètres cités
précédemment, et le programmme peut être amené à trouver un nombre énorme de candidats (quelques
centaines de milliers d’ensembles). Ce paramètre permet de ne sélectionner parmi ces candidats que ceux
qui sont considérés comme étant les meilleurs, et donc de raccourcir considérablement le temps de traitement
de chaque essai. En contrepartie, on se prive potentiellement de trouver le meilleur recalage à cause de
l’heuristique utilisée pour retenir les meilleurs candidats. Lorsque ce champ est désactivé, le nombre maximal
de candidats est illimité, ce qui peut conduire à de très grands temps de calcul.

FIGURE 2.29 – Alignement de deux nuages se recouvrant partiellement. A gauche la configuration initiale, à droite
le résultat du recalage avec un recouvrement estimé à 90% (Overlap = 0, 9) et une vingtaine d’essais (Number of
trials).

Les paramètres Delta et Overlap nécessitent donc que l’utilisateur ait une idée a priori de ce que seront les
nuages après avoir été alignés.

La figure 2.29 présente le résultat obtenu en alignant deux scans d’une peluche relevés sous deux angles sen-
siblement différents. En théorie, la fonction Align est capable de traiter des nuages avec des taux de recouvrement
beaucoup plus faibles que ceux présentés en exemple.

Les alignement calculés via cette fonctionnalité dépendent grandement de la configuration des nuages à traiter.
En effet, leur géométrie ainsi que le degré de ressemblance les rendent plus ou moins facilement comparables. De
ce fait, il se peut que les résultats fournis dans certains cas semblent relativement mauvais. Dans ces situations, vous
pouvez alors utiliser la fonction de recalage fin décrite en section 2.3.3. Il est même conseillé, de manière générale,
d’avoir recours au recalage fin après utilisation de cette fonctionnalité.

Cette fonction crée une copie du nuage Data aligné sur le nuage Model. Il n’est donc pas nécessaire de cloner
les nuages avant, puisqu’ils ne sont pas modifiés directement.

Choix des rôles (interface générique)

Cette interface générique (figure 2.30) est utilisée par toutes les méthodes de calcul de distance, ainsi qu’un cer-
tain nombre d’autres méthodes (qui l’utilisent comme telle ou sous une forme équivalente). Elle permet à l’utilisateur
d’attribuer interactivement un rôle spécifique à deux entités qui ont été sélectionnées en même temps. CloudCom-
pare force la coloration des entités en fonction du rôle qui leur a été affecté. Dans le cas des distances par exemple,
le nuage de référence est représenté en jaune et le nuage à comparer (celui qui portera le champ scalaire après
calcul), en rouge. Un bouton swap permet d’intervertir le rôle (et donc la coloration) des deux entités.
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FIGURE 2.30 – Interface standard de choix des rôles des entités

2.3.5 Tools > Distances > Cloud/Cloud dist.

Cette fonction permet de calculer les distances (approximatives ou exactes) entre deux nuages de points.

Lors de l’appel de cette fonction, et après avoir choisi le rôle de chaque nuage (Cf. section 2.3.4), un premier
calcul de distances approximatives entre les deux nuages (distances de Chanfrein, calculées via l’octree) est effec-
tué de manière automatique. Cela permet d’afficher dans la partie supérieure de l’interface 2.31 (Approx. results)
diverses informations sur les distances qui peuvent alors être calculées précisément.

Ces informations sont :
– Min. dist. : distance (approximative) minimale
– Max. dist. : distance (approximative) maximale
– Mean. dist. : distance (approximative) moyenne
– Sigma : écart type
– Max relative error : erreur relative maximale de l’approximation (exprimée sous forme d’une fonction de d - la

distance, car cette erreur est dépendante de la distance réelle des points, et généralement décroît rapidement
quand d croît, ce qui veut dire que l’approximation de la distance minimale est généralement très mauvaise,
mais celle de la distance maximale peut-être assez fiable).

L’utilisateur peut enfin afficher l’histogramme des distances approximatives calculées (en appuyant sur l’icone

), mais celui-ci est généralement assez peu détaillé étant donné le principe du calcul des distances de Chan-
frein via l’octree.

La partie inférieure (Precise results) permet le paramétrage du calcul précis des distances. L’utilisateur peut saisir
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FIGURE 2.31 – Interface de paramètrage pour le calcul de distances entre deux nuages de points

les valeurs suivantes :

– Local model : indique quelle une modélisation locale sera appliquée au nuage de référence pour améliorer
la précision du calcul de distance nuage à nuage (dans une certaine mesure). Cette technique permet une
amélioration de la précision globale (et non forcément locale). Cette amélioration dépend du modèle choisi, et
se fait au prix d’un certain ralentissement de la fonction (qui dépend lui aussi du modèle choisi) :
– NONE : pas de modélisation locale (comportement par défaut), on calcule la distance au point le plus proche.
– Least Square Plane : approximation locale du nuage par un plan (ajusté aux moindres carrés) - peu précis

mais rapide.
– 2D 1

2 triangulation : approximation locale du nuage par une triangulation de Delaunay 2D 1
2 (après projection

des points sur un plan ajusté aux moindres carrés) - vitesse et précision intermédiaires.
– Height Function : approximation locale du nuage par une fonction de hauteur du type z = ax + by + cx2 +
dy2+exy (là encore, après projection des points sur un plan ajusté aux moindres carrés) - meilleure précision
mais vitesse réduite.

– Max. dist : permet à l’utilisateur de définir une distance au delà de laquelle il n’est pas nécessaire de calculer
une distance précise. Cela permet d’améliorer fortement les performances du calcul, en particulier sur des
nuages ayant peu de zones communes (en évitant ainsi de calculer des distances éloignées - les plus coû-
teuses - alors que leur connaissance précise est généralement inutile). Les points concernés conservent alors
leur distance approximative. Les informations affichées dans la partie supérieure peuvent grandement aider à
fixer cette valeur limite.

– Octree level : ce paramètre de l’algorithme est normalement adapté au mieux par CloudCompare, mais il est
possible de le forcer au cas où l’heuristique de détermination est défaillante.

Remarques :

– Cette fonction rajoute un champ scalaire C2C Distances au nuage de référence.
– Pour calculer les distance précises il est nécessaire d’appuyer sur le bouton rouge Compute. Autrement, seules

les distances approximatives sont conservées.
– Toutes les distances calculées par cette fonction ou rentrées en paramètre sont exprimées dans la même unité

que les coordonnées du nuage de points (il n’y a plus d’unité explicite dans CloudCompare 2.1).
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2.3.6 Tools > Distances > Cloud/Mesh dist.

FIGURE 2.32 – Exemple de résultat de calcul de distances entre un nuage et un maillage

Cette fonction permet de calculer les distances (approximatives ou exactes) entre un nuage de points et un
maillage.

Cette fonction est largement équivalente au calcul de distances entre nuages (section 2.3.5) mis à part quelques
détails :

– si un seule des deux entités sélectionnées est un maillage, le choix des rôles (section 2.3.4) n’est pas néces-
saire (le maillage est forcément l’entité de référence).

– si les deux entités sélectionnées sont des maillages, les sommets de l’entité comparée seront utilisés en guise
de nuage. Il peut être intéressant d’utiliser la fonction d’échantillonnage de points sur un maillage (Cf. sec-
tion 2.2.13) préalablement, pour avoir une meilleure vision des différences entre maillages (si cela est le résultat
escompté).

– cette fonction rajoute un champ scalaire C2M Distances au nuage de référence (nuage comparé).
– le choix d’une modélisation locale (Local model) n’est pas possible puisque l’entité de référence est ici un

maillage.

2.3.7 Tools > Distances > Closest Point Set

Cette fonction calcule pour chaque point du nuage de référence, le point le plus proche dans le nuage compared.
L’ensemble de ces "points les plus proches" forme un nouveau nuage (Closest Point Set ou CPS).

Remarques
– Pour appeler cette fonction, il faut sélectionner exactement deux nuages de points.
– On retrouve l’interface générique de choix du rôle de chaque liste (Cf. section 2.3.4, qui permet à l’utilisateur

de préciser quel est le nuage d’où sont extraits les points du CPS (nuage compared)et quel est le nuage de
référence.

– Le résultat est un nuage qui a exactement le même nombre de points que le nuage de référence, et dont
chaque point appartient au nuage compared (par définition). Par construction, il peut y avoir des doublons.
C’est un résultat qui est utilisé, par exemple, par l’algorithme de recalage entre deux nuages de points (Cf.
section 2.3.3).
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FIGURE 2.33 – Exemple d’estimation automatique des paramètres d’une loi normale pour un champ scalaire

2.3.8 Tools > Statistics > Compute stat. params

Cette fonction calcule les paramètres de la loi statistique choisie (Gauss ou Weibull) à partir des valeurs du champ
scalaire actif du nuage sélectionné. La fonction renvoie typiquement la moyenne et l’écart-type du champ scalaire
courant si la loi est Normale, ou les paramètres (a, b) si c’est une loi de Weibull (auquel cas CloudCompare affiche
aussi des estimations de la moyenne et de l’écart-type dans la console - voir section 1.1).

La méthode représente graphiquement l’adéquation entre la loi calculée (trait blanc) et l’histogramme du champ
scalaire dans une fenêtre qui apparaît à la fin du calcul (voir figure2.33). Les valeurs des paramètres de la loi sont
affichées en haut de la fenêtre. CloudCompare renvoie enfin, via la console, la distance du χ2 entre la distribution
estimée et les valeurs du champ scalaire.

Remarque : les paramètres de la loi ainsi estimés pourront typiquement être utilisés dans la fonction de test
statistique local (voir section 2.3.9), qui permet de filtrer un nuage de point dont on a calculé les distances par
rapport à un nuage (ou un maillage) de référence.

2.3.9 Tools > Statistics > Statistical test

FIGURE 2.34 – Exemple d’estimation automatique des paramètres d’une loi normale pour un champ scalaire

Cette fonction, centrale dans CloudCompare, permet d’appliquer un test du χ2 local sur un nuage de point muni
d’un champ scalaire. Le test du χ2 est appliqué à chaque point à partir de l’histogramme des valeurs scalaires de
ses n voisins (n étant un des paramètres de l’algorithme). Le test confronte cet histogramme avec une distribution
théorique à deux paramètres (µ et σ dans le cas d’une loi normale par exemple).
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Avant de spécifier les paramètres, l’utilisateur doit choisir le type de distribution théorique (il a le choix actuellement
entre Gauss et Weibull). Le résultat est un nouveau champ scalaire (une valeur pour chaque point - la métrique du
χ2 - qui donne une information sur la concordance locale entre la valeur scalaire et la distribution testée). La théorie
du test du χ2 nous fournit un seuil (calculé à partir de la marge d’erreur p(χ2), dernier paramètre de l’algorithme) qui
permet de classer les points en fonction de leur non-appartenance à la loi testée. Cette loi représentera typiquement
le bruit de mesure, et on obtiendra ainsi l’ensemble des points dont la distance (à l’autre nuage/maillage) ne fait
pas partie du bruit de mesure (par exemple). Ainsi, on aura les points qui ont effectivement subi une modification, un
changement, et on évitera de prendre en compte des points en réalité immobiles mais dont la distance n’est pas nulle
car elle est bruitée. Une fois le nuage séparé en deux classes, on peut garder le groupe des points hors distribution
(voir figure 2.35, en rouge) et les segmenter par exemple en fonction de la proximité relative des points (par une
extraction des composantes connexes - Cf. section 2.3.10).

FIGURE 2.35 – Champ des écarts initial (en haut à gauche), filtrage statistique (en haut à droite), puis extraction des
points hors distribution théorique (en bas à gauche) et enfin extraction des composantes connexes (en bas à droite).

Remarques :
– Pour appeler cette fonction, il faut sélectionner une seule entité 3D, munie d’un champ scalaire actif.
– Pour régler le paramètre p(χ2), il est important de comprendre que le test du χ2 permet uniquement de rejeter

l’hypothèse selon laquelle les valeurs du champ scalaire prises sur le voisinage de chaque point suivent la loi
testée, mais pas l’inverse. Ainsi, plus la marge d’erreur est faible, et plus le seuil du χ2 sera grand (on rejette
moins souvent l’hypothèse citée précédemment, et on classe donc moins de points comme ne suivant pas la
loi testée).

– Inversement, plus p(χ2) est grand, plus on aura de points "hors la loi", colorés en rouge. Notez que ce para-
mètre sert uniquement à pré-positionner les potentiomètres de réglage des couleurs (seuils de coupure et de
saturation des valeurs du champ scalaire) pour l’affichage du résultat à l’écran (Cf. section 1.4.4.1). Ces poten-
tiomètres peuvent être ensuite déplacés par l’utilisateur avant extraction effective des points (par appel de la
fonction Scalar Fields > Filter by Value, qui va créer un nouveau nuage de points ne comportant que les points
présentement affichés à l’écran, c.à.d. les points ne suivant pas la distribution théorique). De plus, la distance
du χ2 est extrêmement divergente et ceci donne une grande marge de manoeuvre à l’algorithme. Ainsi, une
modification relativement grande du seuil de coupure n’aura que peut d’effet sur la classification. Au pire, on
risque de rater un tout petit nombre de points (au niveau des bordures des zones limites).

– Pour obtenir des résultats précis, il faut par contre connaître ou mesurer la distribution du bruit de mesure (une
sorte de bruit moyen, en première approximation, comprenant l’erreur de mesure dûe au capteur, à la surface
scannée, à la lumière, à la température ambiante lors de la mesure, à la création du maillage dans le cas d’une
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comparaison nuage/maillage, etc.). Les paramètres de la distribution statistique correspondante peuvent donc
être définis à partir de connaissances a priori mais peuvent aussi être déterminés à partir d’un champ scalaire
(une portion du nuage typiquement) avec la fonction de calcul de paramètres statistiques à partir d’un champ
scalaire (Cf. section 2.3.8).

– L’algorithme crée un nouveau champ scalaire nomme (Chi2 Distances). Ce champ est ajouté au nuage de
points courant.

2.3.10 Tools > Segmentation > Label Connected Components

FIGURE 2.36 – Interface de paramétrage de la méthode d’extraction des composantes connexes

Cette fonction permet de décomposer un nuage de points en sous-nuages compacts. Si le nuage sélectionné est
composé de plusieurs groupes de points suffisamment dissociés (distants) les uns des autres, il est possible de le
subdiviser assez simplement via l’octree. Ceci est fait dans CloudCompare grâce à une approche d’extraction des
composantes connexes. C’est un algorithme courant, généralement appliqué aux images 2D binaires et qui a été
étendu ici à une grille 3D binaire. Cette fonction produit en sortie une entité par sous-nuage de points (regroupées
dans un nouveau groupe d’entité au niveau de l’arbre de navigation de CloudCompare). La figure 2.35 en bas à
droite est une bonne illustration de son utilité.

L’utilisateur choisit principalement le niveau d’octree auquel l’algorithme sera appliqué (Octree Level). Celui-ci va
en fait définir grossièrement le seuil de distance au-delà duquel les groupes de points (les composantes connexes)
seront considérés comme non connexes. Plus le niveau d’octree est grand, plus le seuil de distance est faible, plus
on extraira de sous-groupes (ce qui n’est pas forcément souhaitable).

Un deuxième paramètre important est le nombre minimal de points par composante connexe (Min. points). Si un
groupe est composé d’un nombre de points inférieur à ce nombre, alors il ne sera pas extrait sous la forme d’une
nouvelle entité. Ceci permet de limiter le nombre de nuages créés par l’algorithme.

Enfin, l’option random colors permet de dire à CloudCompare de générer des couleurs au hasard pour chaque
nouveau nuage.

Remarques :
– Plus le niveau d’octree est grand et plus la mémoire nécessaire (la RAM) est importante. Le niveau d’octree

est donc un paramètre sensible qu’il est difficile de régler a priori, sans expérience. Une approche par niveaux
successifs peut donc être nécessaire (en commençant typiquement au niveau 7). On peut aussi afficher l’octree
(représentation Wire ou Cubes, Cf. section ??) pour estimer visuellement les tailles des cellules aux différents
niveaux.

– Pour appeler cette fonction, il faut sélectionner une seule entité 3D.

2.3.11 Tools > Segmentation > K-Means

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.

2.3.12 Tools > Segmentation > Front propagation

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.
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2.4 Menu ’Display’

2.4.1 Display > Full Screen

Cette fonction permet d’afficher la fenêtre principale de CloudCompare en plein écran. Dans ce mode, la totalité
de l’écran est occupé par l’application. La barre de titre de CloudCompare ainsi que la barre de tache de Windows ne
sont plus accessibles, ce qui améliore le confort visuel mais empêche les manipulations habituelles sur les fenêtres
(déplacement, réduction, changement de fenêtre active, ...).

Pour repasser en affichage normal, il suffit de cliquer une nouvelle fois sur la commande Full screen, ou d’utiliser
la touche de raccourci associée (F11).

Note : il est tout de même possible de changer de fenêtre active, même en affichage plein écran, en maintenant
la touche ALT enfoncée, puis en pressant la touche TAB de manière à faire défiler le sélecteur (cf. figure 2.37) jusqu’à
l’application souhaitée. Lorsque la touche ALT est relachée, Windows active la fenêtre de l’application ainsi sélec-
tionnée. Cette commande est utilisable pour toute application.

FIGURE 2.37 – Sélecteur d’application sous Windows

Raccourci clavier : F11

2.4.2 Display > Refresh

La commande Refresh permet d’actualiser l’affichage dans les contextes graphiques.

Raccourci clavier : F5

2.4.3 Display > Test Frame Rate

Cette fonction permet d’estimer le taux de rafraîchissement de l’affichage dans CloudCompare. Cette valeur,
exprimée en images par secondes (FPS : Frame Per Second), correspond à la fréquence à laquelle l’application
actualise l’affichage.

Le test doit durer une dizaine de secondes, et se caractérise par une rotation autour des objets visibles dans
le contexte graphique actif. Une fois le test terminé, le résultat est affiché dans la zone d’information du contexte
graphique.

Note : ce taux dépend directement du nombre de triangles et de points à afficher. Pour des raisons de confort
visuel (cf. section ??), il est préférable de faire en sorte que le taux de rafraîchissement soit de l’ordre de 25 FPS ou
plus.

Raccourci clavier : F12

2.4.4 Display > Toggle Centered Perspective

Dans le processus d’affichage, la projection définit la manière dont les objets 3D sont dessinés à l’écran de
visualisation 2D. L’affichage de CloudCompare propose deux types de projections :
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– parallèle orthographique : les points sont projetés orthogonalement sur le plan image. Le champ de vision
correspond à un cylindre.

– perspective : les points sont projetés vers un unique point n’appartenant pas au plan image. Le champ de vision
correspond à un cône.

Le plan image peut être assimilé à l’écran de visualisation.

Dans CloudCompare, la commande Toggle Centered Perspective permet de basculer entre l’affichage par pro-
jection orthographique, qui est le mode d’affichage par défaut, et l’affichage par projection perspective. Lorsque cette
commande est activée, le centre de rotation du point de vue est automatiquement placé sur le centre de la scène
observée. Lors des phases interactives (mouvement de souris dans un contexte graphique - cf. section 1.3.1.2), la
caméra tournera donc autour des objets de la scène.

Si elle est sollicitée une seconde fois, cette commande rétablit l’affichage suivant une projection orthographique.

Raccourci clavier : F3

2.4.5 Display > Toggle Viewer Based Perspective

Cette commande intervient sur l’affichage interactif dans les contextes graphiques en permettant de basculer
entre le point de vue centré sur la caméra et le point de vue centré sur la scène.

Un premier appel à cette commande permet de positionner le centre de rotation du point de vue sur la caméra
elle même. Ce mode est associé à une projection perspective (cf. section 2.4.4). Lors des phases interactives (mou-
vement de souris dans un contexte graphique - cf. section 1.3.1.2), la caméra tournera donc sur elle même, en
conservant sa position.

Si elle est sollicitée une seconde fois, cette commande rétablit l’affichage par défaut centré sur la scène et basé
sur la projection orthographique.

Raccourci clavier : F4

2.4.6 Display > Render to File

Effectue une capture d’écran du contexte actif dans un fichier BMP. Cette fonction offre la possibilité d’appliquer
un facteur de zoom au moment de la capture, via la fenêtre présentée en figure 2.38.

FIGURE 2.38 – Fenêtre de zoom pour la capture du contexte graphique courant

2.4.7 Display > Display Settings

Cette fonction permet de régler les paramètres d’éclairage dans CloudCompare, via l’interface visible en figure
2.39. On y distingue 3 parties :

La premier cadre (Light) est dédié au paramétrage de la source lumineuse. L’utilisateur a la possibilité de définir
une couleur pour chacune des trois composantes de la lumière (ambiante, diffuse et spéculaire) :

– La composante ambiante (Ambient) est la lumière constante, dans laquelle la scène baigne : de nuit par
exemple, la composante ambiante est noire (aucune lumière ambiante).
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FIGURE 2.39 – Interface de paramètrage de l’éclairage

– La composante diffuse (Diffuse) définit la couleur réfléchie par les objets indépendamment de la position de la
caméra.

– Pour finir, la composante spéculaire (Specular ) définit la couleur ré-émise par les objets en direction de la
caméra : plus cette composante est lumineuse, plus les objets semblent brillants (au contraire plus elle est
sombre, plus les objets semblent mats).

Le second cadre (Default materials) permet de paramétrer les couleurs appliquées par défaut aux maillages ou
nuages de points. Dans le cas des maillages, l’utilisateur a la possibilité de définir une couleur indépendante pour
chaque côté de la surface (Mesh front / Mesh back ). Le bouton Points permet de définir la couleur des points dans
les nuages, au même titre que la commande présentée en section 2.2.1.

Le dernier cadre (Others) propose de modifier quelques dernières options d’affichage plus générales. Bakcground
permet de régler la couleur de fond des contextes graphiques. Le fond apparaîtra toujours sous forme d’un dégradé
allant de la couleur paramétrée vers le noir. Bounding-box permet de changer la couleur de la boîte englobante
apparaissant autour des objets sélectionnés. Pour finir, Text permet de paramétrer la couleur du texte affiché dans
les contexte graphiques.

Chacun des boutons décrits précédemment permet de saisir une couleur pour le paramètre qui lui est associé,
via l’interface de sélection des couleurs présentée en section 2.2.1.

Les boutons en bas de la fenêtre permettent d’appliquer les paramètres (Ok et Apply ), de réaffecter les valeurs
par défaut à tous les paramètres (Reset), ou de quitter l’interface sans prendre en compte les modifications (Cancel).

2.4.8 Display > Camera settings

Ce dialogue, associé à la vue 3D active, permet de modifier l’orientation et la caméra (via 3 angles : Θ, Φ et Ψ)
ainsi que son centre de rotation (pivot) et son ouverture angulaire (f.o.v. pour "<field of view"> - applicable uniquement
en vision perspective).

Il est aussi possible de :
– stocker l’orientation courante (icône "<caddie">)
– rétablir l’orientation précédemment stockée (icône suivante)
– et enfin appliquer une des 6 orientations pré-définies (haut, bas, gauche, droite, devant, derrière) relativement

à la position stockée (6 dernières icônes)
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2.4.9 Display > Light and Materials > Toggle sun light

Permet d’activer ou désactiver la source lumineuse principale. Il est nécessaire qu’au moins une source lumi-
neuse soit active pour que les effets d’éclairage soient visibles (ombrage, couleur, ...).

Raccourci clavier : F6

2.4.10 Display > Light and Materials > Toggle custom light

Permet d’activer ou désactiver la source lumineuse personnalisée.

Cette source lumineuse est, contrairement à la source principale ("sun light" - Cf. section 2.4.9), une source ponc-
tuelle. Elle apparaît d’ailleurs sous forme d’une petite étoile jaune autour de l’objet (voir remarques ci-dessous). Elle
a par contre les mêmes caractéristiques que la source principale.

Il est possible de la déplacer en maintenant enfoncé la touche CTRL tout en faisant un "PAN" avec la souris
(bouton droit enfoncé).

Remarques :
– Raccourci clavier : F7
– L’étoile n’apparait qu’avec la projection orthographique (voir section 2.4.4 ou 2.4.5).
– L’étoile peut être parfois positionnée initialement à l’intérieur de l’objet !

2.4.11 Display > Console

Cette commande permet d’afficher ou de masquer la console visible par défaut dans la partie inférieure de la
fenêtre principale de CloudCompare (cf. section 1.1).
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FIGURE 2.40 – Source lumineuse secondaire (custom light)

2.5 Menu ’Plugins’

Dans ce menu sont rangés automatiquement les entrées correspondant à chaque plugin chargé au démarrage
de CloudCompare. Pour plus d’information sur ces plugins, voir le chapitre suivant (3).

2.6 Menu ’3D Views’

2.6.1 3D Views > New

Permet d’ouvrir un nouveau contexte (fenêtre) graphique.

Remarques :
– Raccourci clavier : CTRL + F3
– Le nouveau contexte graphique est nommé en fonction du nombre de contextes ouverts depuis le lancement

de CloudCompare. Si n contextes graphiques ont été ouverts durant la session, quelque soit le nombre de
contextes restant, l’élement créé sera automatiquement nommé "3D View n+ 1".

– Les contextes ainsi créés sont vierges : ils ne contiennent aucun objet, et il appartient à l’utilisateur de répartir
l’affichage des entités disponibles comme il le souhaite (cf. section 1.3.1.3)

2.6.2 3D Views > Close

Ferme le contexte (fenêtre) graphique actif.

Remarques :
– Raccourci clavier : CTRL + F4
– Les objets rattachés au contexte graphique ainsi supprimés ne sont réaffecté à aucun autre contexte, et ne

sont donc plus visualisables. L’utilisateur pourra s’il le souhaite répartir l’affichage des objets dans les contextes
graphiques restants (cf. section 1.3.1.3).

2.6.3 3D Views > Close all

Ferme tous les contextes (fenêtres) graphiques.
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2.6.4 3D Views > Tile

Cette commande permet de partionner l’espace d’affichage entre les différents contextes graphiques ouverts.
Les contextes sont disposés de manière à ce que l’espace d’affichage soit entièrement rempli, et qu’il n’y ait aucun
chevauchement entre contextes (ils forment une mosaïque).

Note : Cette organisation est utile pour visualiser tous les contextes simultanément.

2.6.5 3D Views > Cascade

Permet d’organiser les contextes graphiques en cascade : les contextes sont superposés dans l’ordre suivant
lequel ils ont été créés.

Note : l’organisation en cascade est utile lorsqu’il s’agit de naviguer rapidement entre les contextes existants.

2.6.6 3D Views > Next

Cette commande permet de passer au contexte graphique précédent (activation du contexte précédent à la place
du contexte actuel).

Note : L’ordre des contextes graphiques repose sur leur nom, et donc sur leur ordre de création. Le contexte
"précédent" correspond donc au dernier contexte encore ouvert crée avant le contexte actuel.

2.6.7 3D Views > Previous

Cette commande permet de passer au contexte graphique suivant (activation du contexte suivant à la place du
contexte actuel).

Note : Le contexte "suivant" correspond au premier contexte encore ouvert créé après le contexte actuel.

2.7 Menu ’Help’

2.7.1 Help > Help

Affiche la documentation utilisateur de CloudCompare.
Raccourci clavier : F1.

2.7.2 Help > About

Affiche la fenêtre d’information de la version courante de CloudCompare (cf. figure 2.41).

2.7.3 Help > About plugins

Affiche la fenêtre d’information des plugins (figure 2.42). Cette fenêtre affiche sous forme d’arborescence déve-
loppable les plugins disponibles. Les répertoires dans lesquels CloudCompare cherche les plugins sont affichés en
haut de la fenêtre.
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FIGURE 2.41 – Fenêtre d’informations

FIGURE 2.42 – Fenêtre d’information des plugins
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Chapitre 3

Plugins

Les plugins sont des extensions proposant des fonctionnalités avancées, mais qui ne sont pas intégrées direc-
tement dans CloudCompare pour différentes raisons. L’application peut parfaitement fonctionner sans ces fonctions,
dont le domaine d’application est généralement un peu eloigné du coeur de métier de CloudCompare.

Ils correspondent à des fichiers de type librairie dynamique (extensions ".dll" sous Windows et ".so" sous Linux)
qui sont chargés automatiquement au démarrage de l’application et rangés dans le menu « Plugin » et la barre d’ou-
tils éponyme.

Sont présentés ici tous les plugins officiels de CloudCompare. Il est toutefois possible que vous ne retrouviez
pas tous ces plugins dans votre installation, ce qui encore une fois n’entrave en rien le bon fonctionnement de
CloudCompare.

3.1 qEDL - Eye Dome Lighting

Plugin qEDL - Eye Dome Lighting

3.2 qSSAO - Screen Space Ambient Occlusion

Plugin qSSAO - Screen Space Ambient Occlusion

3.3 qPCV - ShadeVis Ambient Occlusion

Cet outil permet de calculer rapidement l’illumination des points d’un nuage ou des sommets d’un maillage par
détermination de la "Portion de Ciel Visible" (P.C.V. - voir figure 3.3).

Cet éclairage consiste à calculer pour chaque point la quantité de ciel qu’il voit, ou autrement dit la quantité d’éner-
gie lumineuse qu’il recevrait si le nuage était éclairé uniformément. Ceci permet de colorier les points en fonction de
leur profondeur relative et fait très bien ressortir le relief et la micro-géométrie. En pratique le calcul est effectué avec
un algorithme équivalent à ShadeVis (proposé initialement par Cignoni et al. du VCG).

Les deux principaux paramètres de l’algorithme, modifiables via la boîte de dialogue associée à la fonction (figure
3.2), sont :

– le nombre de « rayons » lumineux. Pour chaque direction d’éclairement (rayon), l’algorithme projette, via la carte
graphique, les entités selon cette direction et calcule la visibilité des points (ou des sommets d’un maillage).
Cette information est accumulée pour chaque direction et permet de calculer l’éclairement global. Plus le
nombre de rayons est grand, et plus la dynamique est importante et les différences d’éclairement entre deux
points fines. Par contre, le temps de calcul est proportionnel au nombre de rayon.

– la résolution du buffer de rendu. La projection des entités selon une direction se fait dans un buffer vidéo dont
la résolution va jouer sur le pouvoir de séparation entre points. Plus la résolution est forte, et mieux les points
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FIGURE 3.1 – Rendu classique avec normales (gauche) et rendu "PCV" (droite)

seront dissociés (d’où un meilleur calcul de leur éclairement propre et une meilleure finesse du résultat). Par
contre, si la résolution est trop grande, outre un temps de calcul et une consommation mémoire plus importants
(cela dépend des performances de la carte graphique), il faut aussi se méfier du fait que le nuage peut devenir
"poreu" et laisser passer la lumière (voir remarque ci-dessous). Dans le cas d’un maillage ceci ne pose pas
problème. Les cartes graphiques actuelles assurent des performances très intéressantes dans l’absolu, il ne
faut donc pas hésiter à utiliser des valeurs importantes pour ces paramètres (telles que les valeurs par défaut).

FIGURE 3.2 – Interface de paramétrage de PCV

Remarques :
– L’algorithme crée un nouveau type de champ scalaire (« PCV ») et la rampe de couleur « Gray » (niveaux de

gris) est automatiquement activée.
– La lumière simulée par l’algorithme PCV est considérée comme provenant de l’hémisphère des Z positifs. Z
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correspondant à la direction verticale, le nuage de points doit donc être orienté en conséquence avant tout
calcul.. Si la checkbox "360˚ mode" est cochée, la lumière vient du globe complet et la direction ne joue plus.

– Puisque l’illumination calculée par cet algorithme est un champ scalaire, il est possible de jouer avec les poten-
tiomètres de saturation pour régler le contraste. Dans le cas d’un maillage, on peut aussi utiliser les fonctions
de moyenne et de rehaussement du contraste (voir sections 2.2.15 et 2.2.16). Une fois les paramètres correc-
tement réglés, on peut transformer le champ scalaire en couleurs avec la fonction « Scalar Fields > Convert to
RGB » (section 2.2.26).

– L’éclairage provenant du ciel est représenté de manière discrète par un nombre limité de « rayons » lumi-
neux, qui sont échantillonnés de manière uniforme sur l’hémisphère (ou la sphère complète si le mode 360˚
est activé). Il n’y a pas pour autant de lancer de rayons dans ShadeVis (on devrait plutôt parler de direction
d’observation - Cf. l’article de Cignoni et al. pour plus d’informations).

– Dans le cas des maillages, il est possible d’accélérer l’algorithme si le maillage est fermé (option « closed
mesh », activée par défaut).

– Dans le cas des nuages de points, il faut faire attention à ce que la résolution ne soit pas trop grande, sinon
des « trous » peuvent apparaître entre les points lors du rendu interne : cceci est simplement dû au fait que la
densité d’un nuage est limitée, et que pour un niveau de zoom suffisant, on observera toujours des zones sans
information entre les points.

3.4 qHPR - Hidden Point Removal

La fonction Hidden Points Removal tente, comme son nom l’indique, de filtrer le nuage de points sélectionné de
sorte à ne conserver que les points visibles (correspondant à la surface implicite effectivement visible depuis le point
de vue courant). Les points considérés comme étant masqués sont alors cachés. Le résultat dépend donc fortement
du point de vue.

La notion de visibilité pour les points d’un nuage est relativement complexe à estimer. En effet il est très peu
probable qu’un point soit réellement masqué par d’autres points dans un nuage, puisque celà nécessiterait un ali-
gnement parfait entre paires de points ou une densité du nuage telle que les points soient quasiment en contact.
Cette fonction approxime donc la notion de visibilité via un calcul d’enveloppe convexe. Elle se base sur l’article
Direct Visibility of Point Sets de Katz, Tal et Basri, SIGGRAPH 2007.

Pour calculer les occlusions par HPR, il est nécessaire que le contexte graphique du nuage soit en projection
perspective (cf. section 2.4.4). Si ce n’est pas le cas, un message d’erreur prévient l’utilisateur lui demandant d’acti-
ver la projection perspective. L’utilisateur doit ensuite choisir le niveau d’octree utilisé par la fonction (figure 3.4). Le
niveau d’octree permet d’accélerer le calcul de l’enveloppe convexe (structure assez lourde) en réduisant le nombre
de points utilisés (par sous-échantillonnage). Plus le niveau est élevé, et plus le calcul d’occlusion sera fin, mais plus
le traitement sera long.

Une fois le filtrage effectué, celui-ci n’est valide que pour la position de caméra courante (et des positions très
proches dans une certaine mensure). Il faut relancer l’outil pour mettre à jour le filtrage selon tout nouveau point de
vue.

Attention, les points cachés par cette méthodes ne peuvent pas être ré-affichés via une méthode ad-hoc (pour
l’instant). Il faut en attendant utiliser un artifice : activer l’outil de segmentation manuelle sur le nuage (l’icône des
"ciseaux" - section 1.5.1) qui réinitialise l’information de visibilité par point) puis quitter ce mode.

3.5 qPCL - Point Cloud Library bridge

Plugin qPCL - Point Cloud Library bridge

3.6 qPoissonRecon - Poisson Surface Reconstruction

Plugin qPoissonRecon - surface mesh Poisson Reconstruction



66 CHAPITRE 3. PLUGINS

FIGURE 3.3 – Nuage de point complet (en haut) et nuage de point filtré avec la technique "HPR" (en bas)

FIGURE 3.4 – Interface de choix de niveau d’octree

3.7 qKinect - Kinect Cloud Capture

Plugin qKinect - Point cloud acquisition with a Kinect device

3.8 qRansacSD - Ransac Shape Detection

Plugin qRansacSD - Ransac Shape Detection
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Annexe A

Annexes

A.1 Formats de fichiers

A.1.1 Fichiers de primitives 2D/3D reconnus

Extension Type P M RGB NG N S Autre Description
asc, txt,
neu, xyz,
etc.

ascii " " " " "
nuage de points
ASCII

bin binaire " " " "

nuage(s) de
points, format
binaire
spécifique à
CloudCompare

ply ascii /
binaire " " " " " " "

maillage
(Stanford)

obj ascii " " "
maillage
(Wavefront)

soi ascii " "
nuage(s) (Soisic,
Mensi)

(c)bin binaire " "
nuage (C.
Hernandez)

pn binaire " "
nuage (point +
normale)

pv, pcv binaire " "
nuage (point +
valeur)

icm ascii "
association
nuages/images

P : Points
M : Maillages
RGB : Couleurs (Red, Green, Blue)
NG : Niveaux de Gris
N : Normales
S : Scalaires
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A.1.2 Chargement et sauvegarde

Chargement Sauvegarde
asc, txt, neu, xyz,
etc. " "

bin " "

ply " "

obj " "

soi "

(c)bin "

pn " "

pv, pcv "

icm "

A.1.3 Formats ASCII

FIGURE A.1 – Interface de paramètrage de la lecture de fichiers ASCII.

Les nuages de points stockés sous format ASCII ne suivent pas tous le même schéma selon l’application à partir
de laquelle ils ont été créés, notamment concernant :
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– la quantité d’information renseignée pour chaque point. La seule certitude est que l’on dispose systématique-
ment des coordonnées cartésiennes (X, Y, Z) des points. Peuvent s’ajouter à cela les normales, couleurs et
intensités.

– l’ordre d’apparition des informations présentes.
– les caractères de séparation des informations.
– d’éventuels en-têtes de fichiers permettant d’apporter diverses informations, généralement liées à l’application

ayant permis la sauvegarde du fichier.
Pour palier à ce problème, CloudCompare propose, à l’ouverture de tels fichiers, une boîte de dialogue (figure

A.1) permettant à l’utilisateur de paramètrer la lecture des données. Ainsi, il est possible d’ouvrir n’importe quel
fichier ASCII, quelque soit l’application ayant permis de le créer, sous réserve que les données qui s’y trouvent soient
suffisamment structurées :

– chaque ligne correspond à un point
– chaque donnée est séparée de la suivante par un caractère unique commun à l’ensemble du fichier (typique-

ment une tabulation ou un espace)
– la quantité d’information ainsi que l’ordre d’appartion des ces informations sont les mêmes pour chaque ligne

(donc pour chaque point)
La partie centrale de la boîte de dialogue d’ouverture de fichiers ASCII est un tableau dans lequel chaque ligne

correspond à une ligne du fichier lu (donc à un point), et chaque colonne correspond à une information. L’utilisateur
a la possibilité de modifier l’information portée par une colonne, en sélectionnant l’élément pertinent dans la liste
déroulante en tête de colonne (figure A.2).

FIGURE A.2 – Sélection de l’information portée par une colonne.

Remarques :
– il est possible d’ignorer le contenu d’une colonne lors de la lecture, en sélectionnant l’élément "Ignore" en tête

de colonne (par exemple lorsqu’on ne sait pas à quoi correspond une colonne, il est judicieux de l’ignorer plutôt
que de faire une manipulation pouvant induire des erreurs dans la construction du nuage de points).

– lorsque le premier élément d’un vecteur est sélectionné pour une colonne, les colonnes suivantes sont au-
tomatiquement modifiées si elles ne sont pas déja renseignées, de sorte à recréer le vecteur (si l’utilisateur
sélectionne Nx pour une colonne par exemple, et que les deux colonnes suivantes sont non encore paramé-
trées, alors elles seront automatiquement basculées à Ny et Nz respectivement).

Cette boîte de dialogue permet aussi d’indiquer à partir de quelle ligne la lecture de données peut commencer,
de manière à pouvoir ignorer d’éventuels en-têtes de fichiers ne portant aucune information liée au nuage de points.
Pour celà, il suffit de renseigner le champ "Skip lines". Par exemple, dans la figure A.1, les deux premières lignes
composent l’en-tête du fichier, et la lecture doit donc commencer à partir de la troisième ligne (il faut donc renseigner
la valeur 2 pour le champ "Skip lines").

Pour finir, il est possible de renseigner le caractère servant de séparateur dans le fichier (caractère séparant deux
informations successives sur une même ligne), via le champ "Separator". Les boutons "ESP" (espace), "TAB" (tabu-
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lation), "," (virgule) et " ;" (point virgule) permettent de sélectionner rapidement les caractères les plus communément
utilisés à cet effet.

Une fois l’interface paramétrée, cliquez sur OK pour lancer le chargement du fichier.

A.1.4 Formats spéciaux

A.1.4.1 Fichier ICM

Fichier d’association entre un nuage de points et un fichier VRML de définition des photos calibrées (caméra +
fichier image).

Exemple :

fichier «toto.icm »
#CC_ICM_FILE //header
FILENAME=pa4.asc //Fichier de points
FILETYPE=ASC //Type du fichier de points
IMAGES_DESCRIPTOR=photo_match.wrl //Fichier VRML de description des photos

calibrées

fichier «photos_match.wrl »
#VRML v2.0 utf8

DEF photo1.jpg Viewpoint{ //Header photo #1
fieldOfView 0.621379 //F.O.V.
position -10.5418 -15.6091 5.95961 //Centre optique
description «VANNE + PETIT TUYEAU » //Description
orientation 0.70724 -0.37292 -0.600618
3.74252

//Vecteur «visée »

} //Fin de photo #1

DEF photo2.jpg Viewpoint{ //Header photo #2
fieldOfView 0.621379 //etc.
position -3.9782 -21.276 5.95616
description «PORTE »
orientation 0.572629 0.696275 -0.432778
2.02135
}

Un tel fichier VRML peut être généré quasi-automatiquement par un logiciel comme RealWorks (Mensi).

A.1.4.2 Fichier d’export de carte de profondeur

Fichier ASCII d’export de carte de profondeur associée à un capteur. Peut être généré via la fonction Sensor >
Ground-Based Lidar > Export depth buffer (section 2.2.18).

Exemple :
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fichier «Ground Based Laser Scanner.txt »
// CLOUDCOMPARE DEPTH MAP
// Associated cloud : Cloud #0 associated cloud name (as disp. in CC)
// dPhi = 0.005000 [ -0.383052 : 0.319331 ] horizontal angular step
// dTheta = 0.005000 [ -1.626588 : 0.137948 ] vertical angular step
// pMax = 78823.398438 max depth
// L = 353 number of horiz. pixels
// H = 141 number of vert. pixels
/////////////////////////
0.000000 0.000000 18132.496094 1st pixel coordinates (i,j) and depth (z)
1.000000 0.000000 15145.963154 2nd pixel coordinates (i,j) and depth (z)
...
352.000000 140.000000 132135.321542 L*H pixel coordinates (i,j) and depth (z)

A.2 Ligne de commande
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